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p R E F A C E 

About This Guide 

THIS GUIDE DESCRIBES 11iE MACX25 P!ODUCT, AND TEllS YOU HOW TO SET UP 

Macintosh computers on an AppleTalk network system for X.25 

communications with MacX25. 

xiii 



What each chapter contains 

What each appendix 
contains 

Who should read this guide 

This guide is intended for network administrators who are responsible for 
installing and maintaining MacX25 servers on the AppleTalk network system. 

How to use this guide 
This guide begins with general product and installation information and then 
provides instructions for using each aspect of the MacX25 Admin program. 

This guide contains the following eight chapters. 

• Chapter 1 gives a basic overview of the MacX25 product. 

• Chapter 2 contains information about setting up a Macintosh computer 
to run the MacX25 Server software, and about installing the necessary 
software on each MacX25 user's Macintosh. 

• Chapter 3 tells you how to get started with MacX25 Admin. 

• Chapter 4 tells you how to set up and manage MacX25 servers on the 
AppleTalk network. 

• Chapter 5 tells you how to control user access to the MacX25 servers. 

• Chapter 6 contains instructions for setting X25 parameters. 

• Chapter 7 describes how to build a Master Address Book for your MacX25 
users. 

• Chapter 8 discusses how to use MacX25 Admin to view activity on the 
MacX25 servers . 

This guide provides the following appendixes. 

• Appendix A contains a table that summarizes the functionality provided 
by the MacX25 product. 
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A quick reference card 
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Conventions 

• Appendix B contains a series of tables that list the X.25 parameter 
settings in each parameter file that comes with the MacX25 product. 

• Appendix C contains a brief description of each parameter that you can 
set with the MacX25 Admin program. 

• Appendix D lists the messages that may appear in the MacX25 Admin Log 
window. 

• Appendix E summarizes how MacX25 Admin shows slot conditions and 
MacX25 server status. 

For your convenience, you will find a quick reference card at the back of this 
guide. The card contains brief instructions for using MacX25 Admin to create 
and start a MacX25 Server, to set access priviledges for a MacX25 user, and to 
add an entry to the Master Address Book. 

What you need to know 

This guide assumes that you are familiar with the Macinto.sh® computer, 
with X.25 networks, and with an AppleTalk network system. 

To use this guide most effectively, you should recognize the following 
conventions in the text. 

Boldface type 

As you read, you will notice certain words and phrases in the text appear in 
boldface type. These are new ternJS and they are defined in the glossary in 
the back of this guide. (This feature is not implemented in this beta draft). 

Special messages 

The following words and symbols indicate special messages to you: 

xv 



+ Note: Text set off in this manner presents an interesting point of 
information or a consideration that you should make as you read the 
surrounding text. 

6 Important Text set off in this manner presents important information that you must 
consider as you read the surrounding text. t::. 

Check list of MacX25 Server 
requirements 

Check list of MacX25 User 
requirements 

This section briefly lists what you need to run the MacX2S Server software. 
See Chapter 1 for more detailed information about the requirements for 
MacX2S Adrnin. 

• a Macintosh II family computer 

• System 6.03 or greater 

• at least 2 MB of RAM 

• ADSP, Server Agent, Apple IPC, and Open Book in your System Folder 

• MacX25 Folder containing MacX2S 1.0, MacX25 Admin, and at least one 
parameter file 

Before users can use the MacX25 servers, you need to use MacX25 Admin to 
create 

• MacX25 Servers and MacX25 Users ftles 

• a Master Address Book with at least one entry 

This section briefly lists what you need to run the MacX25 User software. 
See Chapter 1 for more detailed information about the requirements for this 
product. 

• a Mac Plus, Macintosh SE family, or Macintosh II family computer with a 
hard disk. 

• System 6.03 or greater 

• at least 1 MB of RAM 

• ADSP, X2S, and Open Book in your System Folder 

Before you can access MacP AD, you need 
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• to install the MacX25 User software on the Macintosh 

• to purchase and install a terminal application that uses Apple's 
Communications Toolbox interface 

To use the Macintosh features of MacPAD, you need to use the Chooser to 
create an Addresses file in your System Folder. See the MacX25 User's Guide 
for instructions. 

What you need to do 

MacX25 Admin is the administration program for MacX25 Server. You use 
this application to download the MacX25 Server software to each Apple Serial 
NuBus Card and to start X25 operations. Figure 2-1 graphically shows a the 
list of tasks that you must perform to set up a Macintosh for MacX25 Server. 

• Figure 2-1 Sening up MacX25 servers 

Server with Livonia card 

D w v ~ 
~ ~ "' -

Tasks Fies created 

Install the software & 
Creaie die MacX25 servers [!J 
Add users to the MacX25 gaieway [!J 
Tafor parameter files, 00 {needed 

&Jild a ~ter address book I 
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Where to look for 
information 

Use Table P-1 to determine where to find instructions for each 
administrative task that Figure P-1 shows. 

• Table P-1 Where to find the instructions 

Task Where to find instructions 

Installing the communications card 
Installation Guide 

and Chapter 2 of this guide 

Installing the MacX25 software Chapter 2 

Apple Serial NuBus Card 

Using MacX25 Admin the first time Chapter 3 

Creating a MacX25 server Olapter 4 

Adding a MacX25 user Chapter 5 

Tailoring MacX25 parameter files Chapter 6 

Building the Master Address Book Chapter 7 

Viewing MacX25 server ac.tivity Chapter 8 

Related documents 

The MacX25 Admintstrator's Guide is part of a suite of documents for the 
MacX25 produc.t. The other guides that relate to MacX25 include: 

• The MacX25 User's Guitk, which contains information about installing 
and using the MacX25 User software 

• The MacX25 Programmer's Guide, which contains information about the 
programmatic interfaces to the MacX25 product 

Because MacX25 works with other products, you may also find the following 
documents useful 

• The Communications ToolBax Programmer's Guide, which contains 
information for developing connection tools, terminal tools, and file 
transfer tools that use Apple's communications interface 
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The MacX25 Product 

M ACX25~ " AN APPLE PRODUCT THAT LINK5 MACINTOSH• PERSONAL 

computers on an AppleTalk network to packet-switched data networks 

supporting the Consultative Committee on International Telegraphy and 

Telephony (CCITI) Recommendation X25. 

This chapter describes how Apple brings X.25 into its AppleTalk network 

system and lists the hardware and software requirements for MacX25's two 

major components, MacX25 Server and MacX25 User. 



A link to the X.25 network 

How MacX25 brings X.25 to the AppleTalk 
Network System 

Your MacX25 package contains MacX25 Server and MacX25 User software. 

MacX25 Server allows a Macintosh II family computer to support X.25 links 
into standard public or private packet-switched data networks and to extend 
access to the X.25 links to other Macinta;h computers over AppleTalk. 

MacX25 User enables Macintosh computers on the AppleTalk network to 
share the X.25 links that a MacX25 server provides to connect to host 
computers on the X.25 network. MacX25 User also provides a standard PAD 
interface, called MacP ADTM, for end-to-end communications between the 
user's Macintosh and the remote host computer. 

X.25 customers can subscribe to a variety of services from a packet­
switched, wide-area data network. For limited network use, users often 
pref er to dial into the network. Networks charge for this service with per 
call and call duration rates. For more substantial use, users can save money 
by leasing a direct line into the network, usually for a flat monthly rate. 

MacX25 Server puts X.25 communications on Apple's intelligent Serial 
NuBus111 Card, which can reside in a NuBus111 slot of any Macinta;h II family 
computer. With the appropriate cabling, you can connect the card directly to 
an X.25 network switch. When the properly connected serial card is running 
the MacX25 communications software, it functions as a MacX25 server, 
providing one X.25 link that registered MacX25 users can share.· 

The Macintosh running MacX25 Server is a MacX25 gateway between an 
AppleTalk network system and a packet-switched data network. MacX25 
Server features an administration program that runs on the MacX25 gateway 
and that makes it easy to create and manage MacX25 servers, to control user 
access to the MacX25 servers, and to simplify server use for MacX25 users. 
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A PAD for host to 
Macintosh 
communications 

All but one of the NuBus slots can be used by Apple Serial Cards supporting 
MacX25 servers. (The Video Card that supports the monitor requires one 
slot.) For example, a Macintosh Hex can support one or two MacX25 servers, 
while a Macintosh II or Ilx can support up to five MacX25 servers. Figure 1-
1 shows a MacX25 gateway with two MacX25 servers. F.ach MacX25 server 
supports one X25 link to a packet-switched data network. 

• Figure 1·1 How MacX25 brings X.25 to the AppleTalk network system 

AppleTalk 

nerMY.k - --------------

M&cX25 s~ ruruq"' - I 4f I 
Apple Seial NuBus Cards 

A packet assembler disassembler, or PAD, is a program that accumulates 
characters from a user terminal or terminal application, assembles the 
characters into X.25 data packets, and transmits the data packets over an 
X25 network connection to a Host computer. Similarly, a PAD disassembles. 
X.25 data packets that it receives from the Host computer and displays the 
characters on the user's terminal. 
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Macintosh 
communications in 
.systems software 

What you need to run 
MacX25 Server 

A PAD performs other functions as well. For example, a PAD stores 
information about the display charac.teristics of a terminal, and these display 
charac.teristics can be modified according to what the host computer expects 
and the terminal supports. Also, a PAD can assemble and send certain X25 
control packets to establish a new X.25 connec.tion, or to interrupt data 
transfer during an ac.tive connec.tion to get status information about the 
connec.tion or to perform a connection maintenance task. 

MacX25 User contains a CCITI conformant PAD program, called MacPAD. 
Figure 1-1 shows several Macintosh computers that have MacX25 User and 
that are connected to an AppleTalk network system. These Macintosh 
computers can share the MacX25 server's X.25 links to connec.t to a host 
computer on the packet-switched data network and to send and receive X.25 
packets between the user's Macintosh and the remote host computer. 

MacP AD is a connection tool that you can access from any terminal 
application that uses Communications Toolbox. 

Communications Toolbox is Macintosh system software that supports 
multiple types of connections, terminals, and file transfer methods. The 
Macintosh system version 6.03 and later includes the Communications 
Toolbox as pan of the System file, and provides a Communications folder 
with several connection tools, terminal tools, and file transfer tools. 

What you should know about MacX25 Server 

This section tells you what you need to run MacX25 Server, discusses some 
important fac.tors to consider about communications between MacX25 
Server and the X.25 network you are using, describes what is on the MacX25 
Server disk, and mentions some of the files that MacX25 Admin creates when 
you use this application. 

This section describes what a Macintosh must contain to run MacX25 Server. 
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Hardware requirements 

The minimum hardware required for MacX25 Server is 

• a Macintosh II family computer equipped with 

o 1 megabyte (MB) of memory 

o a 20 MB hard di.sk 

• a Serial NuBus Card for each MacX25 server that the the MacX25 gateway 
supports 

You must use one NuBus slot in the MacX25 gateway for the Video Card 
that supports your monitor. You can install Serial NuBus Cards in any or all 
of the remaining slots. 

You must purchase the Serial NuBus Card and its required cabling separately 
from the MacX25 product. Chapter 2 contains MacX25-specific information 
that you must consider when purchasing a Serial NuBus Card for X25 
communications with the MacX25 product. 

System requirements 

MacX25 Server requires System 6.03 or greater. You can purchase a System 
6.03 upgrade from your local Apple dealer. 

Other software requirements 

To use MacX25 Admin, your Macintosh must contain all of the MacX25 
Server software in the appropriate locations on your hard disk. See Chapter 2 
for instructions on installing the MacX25 Server software. 

Because MacX25 servers can be active only when MacX25 Admin is running, 
you must run MacX25 Server under MultiFinder to use other programs on the 
MacX25 gateway. 

+ You cannot run MacX25 Server on a Macintosh that is running 
AppleShare® or LaserShare® because these products do not run under 
MultiFinder. 
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X.25 network 
considerations 

When the Macintosh is busy processing, MacX25 users may not be able to 
connect to a MacX25 server. For example, while you are dragging your mouse 
down the MacX25 Admin menus, the Macintosh is busy and MacX25 users 
cannot gain access to any of the MacX25 servers that it supports. This does 
not affect users who already have connections through a Mad{25 server. 

This section discusses X.25 network details that you must consider prior to 
implementing MacX25 as your X.25 connectivity prcx:luct. 

Functionality 

MacX25 is a comprehensive X.25 prcx:luct that provides the functionality that 
most X.25 customers require. However, there are some X.25 services that 
MacX25 does not support. Appendix A summarizes the X.25 functionality 
that MacX25 Server provides. 

Network parameters 

When you subscribe to X.25 services from a network vendor, you must 
negotiate approximately 150 variables, or parameters, for your particular 
situation. You must then set your X.25 parameters to match the negotiated 
values. 

MacX25 Server includes several parameter files, each containing a complete set 
of X.25 parameters. You can dynamically set approximately 31 parameters 
from within MacX25 Admin; the other parameters are static values and you 
cannot change them. 

In most cases, one of the supplied parameter files will fit your needs. 
Appendix B contains tables that show the values of each static parameter 
within each of the supplied parameter files. You may prefer to bring this 
information with you when you negotiate parameters with your network 
vendor. 

If none of the supplied parameter files fits your needs, you should contact 
your Apple Technical Support representative for assistance. 
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What the MacX25 Server 
disk contains 

Throughput issues 

A MacX25 server can support up to 64 virtual circuits transferring data in 128-
byte packets. With MacX25 Admin, you can dynamically set bolh the 
number of virtual circuits and the packet size. The maximum number of 
virtual circuits you can specify is 64. The maximum packet size is 4096 bytes. 
Keep in mind that the number ci virtual circuits that the server can support 
diminishes as the packet size increases. For example, if you plan to send and 
receive 4K-byte packets, the server may only support up to four virtual 
circuits. 

Memory issues 

To run MacX25 Admin under MultiFinder, your Macintosh must contain at 
least 2 MB of RAM. 

The window size and packet or frame size parameter senings that you set 
through MacX25 Admin affect how much Macintosh memory is required for 
network transmissions. If you set your X.25 parameters for large window 
sizes and for large packet and frame sizes, your MacX25 gateway may require 
additional RAM. 

The software required to run MacX25 Server is contained on a single 800 
kilobyte (KB) disk. Figure 1-2 shows the contents of the MacX25 Server 
disk. 

At the top level, the MacX25 Server disk contains a System Folder, a ReadMe 
file, and the TeachText application. 
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• Figure 1-2 Contents of the Mac)QS Server disk 
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The System Folder 

The System Folder does not contain a complete system. The System 
Folder contains 

• Apple IPC, which is a startup document (or !NIT file) for InterProcess 
Communications (!PC). Apple !PC handles NuBus communications 
between the Macintosh and the Serial NuBus Card 

• ADSP, which implements the AppleTalk Data Stream Protocol and is used 
for communications between a MacJ{25 server and the user's Macintosh 
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Other files you create with 
MacX25 Admin 

• Server Agent, which is a startup document that handles 
communications between ADSP and Apple !PC 

• Open Book, an application that displays information from the Master 
Address Book and Addresses files and that allows you to modify its 
contents 

• MacX25 Folder, which contains 

o MacX25 Admin, the program that you use to perform all of the 
administration tasks for the MacX25 gateway 

o MacX25 1.0, which contains the X.25 communications software 

o one or more parameter files that contain the parameter settings 
necessary to run MacX25's X.25 communications software over a 
specific network. For example, Telenet Parameters contains the 
appropriate parameter settings for Telenet 

ReadMe and TeachText 

The ReadMe file and its accompanying TeachText application provide the 
standard program overview information for the disk. 

When you open the Reac!Me file, it uses the TeachText application to display 
this information to you. You can scroll through the text as you read it and 
you can print the ReadMe file. 

When you are finished, choose Quit from the File menu to return to your 
desktop. 

This section describes some programs that are nct included on the MacX25 
Server disk, but that MacX25 Admin creates when you use this application. 

MacX25 Servers and MacX25 Users 

When you use MacX25 Admin for the first time, it creates two files, MacX25 
Servers and MacX25 Users. As you use the program, it stores any 
infonnation you save about a MacX25 server in the MacX25 Servers file and 
any information you save about users in the MacX25 Users files. 

Figure 1-3 shows how these two files appear in the MacX25 Folder. 
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• Figure 1-3 The MacX25 Servers and MacX25 Users files 
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Master Address Book 

The Master Address Book is a file that contains connection inf onnation that 
a program, like MacPAD, can use to establish or receive X.25 calls through a 
MacX25 server. 

You can create this file by choosing MacX25 Admin's Open Master Address 
Book command or by launching the Open Book application. 

After you put infonnation into the Master Address Book, a MacX25 user can 
use the Chooser desk accessory to copy infonnation from the Master 
Address Book on the MacX25 gateway to a file, called Addresses, on the 
user's Macintosh. The X25 Chooser document, which is included in the 
MacX25 User software, provides this capability. / , 

Figure 1-4 shows how the Master Address Book file and the Open Book 
application will appear in the System Folder of the MacX25 gateway. 

• Figure 1-4 The Open Book application and iis Master Address Book file 

I 
Open Book Master Address Book 
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What MacX25 users need 

Parameter files 

The MacX25 Server disk provides several parameter ftles that you can select 
for individual MacX25 servers. MacX25 Admin allows you to open and 
modify a parameter file and to save changes to the existing parameter ftle or 
to a new parameter file. Figure 1-5 shows examples of MacX25 parameter 
mes. 

• Figure 1-5 MacX25 parameter files 

I I I I 
DCE Telenet DTE Telenet Telenet Dial Out New file 

What you should know about MacX25 User 

This section lists the requirements for MacX25 User, describes what is on the 
MacX25 User disk, and discusses the files that are created when users follow 
the instructions in the MacX25 User's Guide. 

This section describes what MacX25 users need to have in order to use 
MacPAD. 

Hardware requirements 

You can run MacX25 User on a Mac Plus and on the Macintosh SE and 
Macintosh II families of personal computers. The Macintosh should have a 
hard disk. 
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What the MacX25 User 
disk contains 

System requirements 

MacX25 Server requires System 6.03 or greater. The user can purchase a 
System 6.03 upgrade from a local Apple dealer. 

Other software requirements 

To use MacPAD, the MacX25 User software and a terminal application that 
uses the Communications Toolbox must be available on the user's 
Macintosh. 

·The MacX25 User disk does not contain a terminal application. Users should 
purchase this from a .local Apple dealer. 

The 800 KB MacX25 User disk contains a System Folder, the MacPAD Tool, a 
Setup Folder, the TeachText application, and a ReadMe file. Figure 1-6 shows 
the contents of the MacX25 User disk. 
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• Figure 1-6 Contents of the Ma005 User disk 
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System Folder 

The System Folder contains : 

• the required versions of the System file and the Finder 

( ) 
/ 
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• the standard device files for the Control Panel, such as the General, 
Keyboard, Key Layout, Monitors, Mouse, Sound, Color, and Startup Device 
files 

• standard desk accessories, such as the Scrapl:x:Jok and Qipooard files 

• ADSP, which implements the AppleTalk Data Stream Protocol 

• the X.25 Choa;er document, which displays X25 services to the user from 
within the Chooser desk accessory and which allows the user to copy 
information from the Master Address Book to the local Addresses file 

• Open Book, the application that displays infonnation from the user's 
Addresses file and that allows the user to modify its contents locally 

Setup Folder 

The Setup Folder contains : 

• Installer, a program that automatically copies the necessary programs 
and files from the MacX25 User disk to the hard disk of the Macintosh 

• MacX25 User Install, a file that contains information that the Installer 
program requires to perform its software installation tasks 

You can find instructions for using the Installer program in Chapter 2 of this 
guide. The MacX25 User's Guide also includes these instructions. ,, ~ 

MacPAD Tool 

The MacPAD Tool has the connection software for MacPAD connections 
through the Communications Tooloox 

ReadMe and TeachText 

The ReadMe file contains some basic overview information aoout the 
MacP AD product and the latest information about MacX25 User that is not 
covered in the MacX25 User's Guide. When a user opens ReadMe, the 
TeachText application displays this information to the user. The user can 
scroll through the text to read it and can print the file. When fmished, the 
user chooses Quit from the File menu to return to the desktop. 
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Other files users create 

( 

This section describes some files that do not appear on the MacJ{25 User 
disk, but that are created by, required by, or used by its programs. 

Addresses 

MacP AD uses the Open Book application to display a list of host names 
when the user sets up a MacP AD connection. 

Open Book gets its information from a file called Addresses in the user's 
System Folder. Open Book automatically creates this file when the user 
follows certain procedures described in the MacX25 User's Guide. 

The Addresses file has the same icon as the Master Address Book, which 
Open Book also creates. 

Terminal session documents 

Terminal applications for the Macintosh usually allow you to save the 
current connection setup information into a file that the application owns. 
This type of file, called a terminal session document, usually appears on the 
desktop as a document icon with the application's icon inside it. When you 
double click on this type of document, you launch the program that created 
the document with the saved settings. This feature saves you time and 
makes the product easier to use. 

Figure 1-7 illustrates this concept by showing the icons for the original 
MacTerminal application and one of its terminal session documents. 

• Figure 1-7 MacTerminal application and session document 

~ ~ 
MacTerminal My session 
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C H A P T E R 2 

Initial Setup 

p REPARING YOUR APPLETALK NETWORK SYSTEM FOR lt25 COMMUNICATIONS 

with MacX25 involves several tasks. You must set up a Macintosh II family 

computer as a MacX25 gateway by installing Apple Serial NuBus cards in it 

and by copying the MacX25 Server software onto its hard disk. You must 

also install MacX25 User software on the Macintosh of each user. 

This chapter contains MacX25-specific information for installing Apple Serial 

NuBus Cards, and gives detailed instructions for installing the MacX25 Server 

and MacX25 User software. 
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Installing the communications card 

The MacX25 Server's X25 software runs on an Apple Serial NuBus Card in a 
NuBus slot of a Macintosh computer. Depending on the model, the 
Macintosh has three or six NuBus slots. You must use one slot for the Video 
Card that supports your monitor. You can install Apple Serial NuBus Cards in 
any or all of the remaining slots. See the Appk Serial NuBus Card 
Installation Guide for instructions. 

The Apple Serial NB card requires either a Hydra cable and a V.35 cable. 
Because MacX25 will work with either of these cables, you may choose the 
cable that best fits your needs. 

Each of these cables has a connector that is marked J-62. You plug the J-62 
connector into the serial card's port at the back of the Macintosh. For more 
detailed instructions, see the Apple Serial NuBus Card Installation Guide. 

The Hydra cable has four DB25 connectors (or ports), which are labeled IA, 
1 B, 2A, and 2B. The V.35 cable has two connectors, which are labeled IA and 
2B. MacX25 requires the lA connector on either cable. 

6 Important Always use the connector marked IA to connect to your X25 network 
equipment, regardless of which cable you are using with the serial card and 
regardless of your line speed. You cannot use any of the other connectors on 
the Hydra cable or on the V.35 cable for communications with MacX25. 6. 

Installing the MacX25 Server software 

The MacX25 Server disk contains all of the MacX25 Server software. The disk 
does not include a complete system, and no Installer program is required or 
provided. 
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Check your system version 

Copy the MacX25 Server 
files 

This section describes how you install the MacX25 Server software on your 
MacX25 gateway. 

MacX25 Server requires version 6.03 or later of the System file and version 6.1 
or later of the Finder. To make sure that these files are installed on your 
system:. 

1. Double-dick on your hard disk icon to open it 

2. Open the System Folder on your hard disk. 

3. Select the Finder. 

4. Choose Getlnfo from the File menu to check the version of the 
Finder. 

5. Close the Get Info window by clicking the close box in the upper­
left corner. 

6. Select the System file. 

7. Choose Getlnfo from the File menu to check the version of the 
System file. 

8. Close the Get Info window. 

If you do not have the required version of either of these files, you must 
upgrade your system. See your local Apple dealer for information on 
obtaining a System 6.03 upgrade for your Macintosh computer. 

To copy the MacX25 Server programs and files, follow these steps: 

1. Insert the MacX25 Server disk into the disk drive of the Macintosh 
that you will use as the MacX25 gateway. 

2. Open the MacX25 Server disk by double-clicking its icon. 

3. Open the System Folder of the MacX25 Server disk. 
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4. Drag the Apple IPC, ADSP, Server Agent, and Open Book files 
from the System folder of the MacX2S Server disk to the System 
Folder of your batcl disk. 

The system displays a chart that shows the progress of the copy 
operations. 

S. Drag the MacX2S Folder from the MacX2S Server disk to the your 
batddJsk. 

You can put the MacX25 Folder anywhere on your hard disk. 

The system displays a chart that shows the progress of the copy 
operations. 

You may find it convenient to display the MacX25 Folder directly on your 
desktop. You can display the MacX25 Folder on your desktop by 
dragging its icon to your desktop after you copy it to your hard disk. 

6. Restart your Macintosh. 

The system ejects the MacX25 Server disk and puts the MacX25 programs 
into effect. 

You can now begin working with MacX25 Admin by following the 
instructions in Chapter 3, or you can install the MacX25 User software on the 
MacX25 gateway (or on other Macintosh computers) as the next section of 
this chapter describes. 

Installing the MacX25 User software 

This section contains instructions for installing MacX25 User on a Macintosh. 

Although you do not need to install MacX25 User on the MacX25 gateway to 
use MacX25 Admin, you may want to use MacPAD or the X25 Chooser from 
the gateway to test your MacX25 servers when you first start them. 

You can also follow these instructions to install MacX25 User on other 
Macintosh computers on the AppleTalk network. 
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To install MacX25 User with the Installer program: 

1. Insert the MacX25 User disk into the disk drive of the Macintosh. 

2. Open the MacX25 User disk by double-clicking its icon. 

3, Open the Setup Folder by double-clicking its icon. 

4. Double-click the Installer icon to launch the Installer program. 

A window like the one shown in Figure 2-1 appears. 

5. Click Install 

The Install program copies the necessary mes from the MacX25 User disk 
to the Macintosh hard disk and notifies you when it completes the 
process. 

• Figure 2-1 The Installer window 
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6. Click Quit to return to the Macintosh desktop. 

7. Close the MacX25 User dJsk and eject it. 

At this point, the X.25 Ot~er and MacP AD programs are available on the 
Macintosh system. You can use these programs, however, only after you 
have created and started a MacX25 server on the MacX25 gateway and have 
set appropriate user access privileges for the server. 

You access MacPAD from a terminal application that uses the 
Communications Toollx>x. See your local Apple dealer for information on 
terminal applications that are compatible with MacPAD. 
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C H A P T E R 3 

Getting Started with MacX25 Admin 

AFTER YOU SET UP THE MACX2S GATEWAY WITH APPLE SERIAL NUBUS CARDS 

and with the MacX25 Server software, you can begin using the MacX25 

Admin application to perform the administrative tasks for the MacX25 

gateway. 

This chapter introduces you to MacX25 Adrnin and tells you how to get 

started with it. 

23 



24 

Introducing MacX.25 Admin 

You use the MacX25 Admin application to create and maintain a MacX25 
gateway. The MacX25 gateway consists of the following files: 

• a MacX25 Servers file 

• a MacX25 Users file 

• one or more X.25 parameter files 

• a Master Address Book file 

The first time you launch MacX25 Admin, you must enter an Admin key of 
your choice. When you enter this key, MacX25 Adrnin creates the MacX25 
Servers file and stores the Admin key in it. Then, MacX25 Admin creates the 
MacX25 Users file and stores Guest user information in this file. 

As you use the program, MacX25 Admin stores in the MacX25 Servers file any 
server information that you save, and stores in the MacX25 Users file any 
user information that you save. 

The MacX2S Folder contains parameter files for several widely used X.25 
public networks. With MacX2S Adrnin, you can assign one of these 
parameter files to each MacX25 server you create. You can also modify some 
of the settings in an existing parameter file, save the settings to a new 
parameter file, and then assign the new parameter file to a MacX2S server. 

MacX25 Admin creates the Master Address Book file when you open this file 
for the first time from within MacX25 Admin. 

All of these files must reside in the MacX25 Folder. The MacX2S Folder can 
reside anywhere on the hard disk <i your MacX25 gateway. 
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6 Important Do not move any of the files or programs in the MacX25 Folder to another 
location on your hard disk because MacX25 Admin uses only the files and 
programs in the MacX25 Folder. 6 

Launching MacX25 Admin for the first time 

To use MacX25 Admin for the first time, follow these instructions: 

1. Double-click your hard disk icon to open your hard disk. 

The system displays a window containing the files and folders on your 
hard disk. 

2. Locate the MacX25 Folder. 

3. Open the MacX25 Folder by double-clicking its icon. 

The system displays the contents of the MacX25 Folder. 

4. Doub.le click the MacX25 Admin icon. 

MacX25 Admin displays the dialog box that Figure 3-1 shows. 

• Figure 3-1 MacX25 Adrnin's first dialog box 
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The message, "No MacX25 Servers File," indicates that MacX25 Admin can 
not find the MacX25 Servers file in the MacX25 Folder. Because you are 
using MacX25 Admin for the first time, this file does not exist yet. 

The message, "Installing MacX25", indicates that MacX25 Admin is 
creating the MacX25 Servers file. 

5. Type the characters that you want for your Admm key and then 
click OK. 

You can type in any characters you want for your key. If you click OK 
without typing anything, no key is stored or required for MacX25 Admin. 

When you click OK, MacX25 Admin displays the dialog box that Figure 3-2 
shows. 

• Figure 3-2 Verifying the Adrnin key 

The Admin key will be required 
before MacH25 Admin can be used 
again. Rre you sure that it is 
correct? 

fi Ok D ( cancel 

6. Click OK, if you want the characters that you just typed to be used 
as the Admin key. 

When you click OK, MacX25 Admin saves your Admin key in the MacX25 
Servers file. 

MacX25 Admin then displays the dialog box that Figure 3-3 shows. 
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• Figure 3-3 MacX25 Adrnin's next dialog box 

• 

No M1tcH25 Users File. 
Creating One . 

n Ok 1 

The message, "No MacX25 Users File,• indicates that MacX25 Admin can 
not find the MacX25 Users ftle in lhe MacX25 Folder. Because you are 
using MacX25 Admin for the first time, this file does not exist yet. 

7. Click OK. 

MacX25 Admin is creates the MacX25 Servers file, stores Guest user 
information in it, and closes the dialog box. 

The MacX25 Admin and MacX25 Log windows now appear on your 
screen. Figure 3-4 shows how these windows appear when you are using 
MacX25 Admin for the first time. 

The MacX25 Admin and MacX25 Log windows contain information about 
your MacX25 gateway. You cannot make any changes to these windows. 

The MacX25 Admin window has a picture of the Macintosh NuBus slots, and 
list boxes labeled Servers Users. 

By the way a slot appears in the MacX25 Admin window, you can tell 
whether or not the slot contains an Apple Serial card. In Figure 3-4, only 
slots 3 and 4 have Apple Serial cards. The slots labeled 1, 2, 5, and 6 are either 
empty or they contain a different type of card. 
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• Figure 3-4 The MacX25 Admin and MacX25 Log windows 
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In Figure 3-4, the Servers and Users list boxes are empty because you have 
not created any servers yet. 

The MacX25 Log window lists any events that occur while the program is 
running. For example, in Figure 3-4, the log lists one event, that the program 
has started. 

28 MacX25 Administrator's Guide - Beta Draft 5/31/89 APPLE CONFIDENTIAL 



f 

Putting MacX25 Admin 
into its administration 
mode 

Making changes to the MacX25 gateway 

To insure your MacX25 gateway's security, MacX25 Admin has two 
operating modes: information mode and administration mcx:le. MacX25 
Admin always opens in its information mode. To make any changes to the 
MacX25 gateway, you must put MacX25 Admin into its administration 
mode. 

To put MacX25 Admin into its administration mode, follow these steps: 

1. Choose Administration from the Special menu. 

Figure 3-5 illustrates this choice. 

• Figure 3-5 Choosing Administration from the Special menu 

MacX25 Admin displays the dialog box that Figure 3-6 shows. 

• Figure 3-6 Entering your Admin key 
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2. Type your Admin key, and dick OK. 

If you entered an incorrect key, MacX25 Admin displays an error message. 
aick OK. 1ben type the correct Admin key and click OK. 

If the key you typed is correct, MacX25 Admin enters its administration 
mode. Figure 3-7 shows how your screen may appear when you first 
enter administration mode. 

• Figure 3·7 Your first look at MacX25 Admin1s administration mode 
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When you put MacX25 Admin into its administration mode, your screen 
changes in the following ways: 

• the MacX25 Admin window disappears from your display 

• the options under the File menu change 

• the Special menu disappears 
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Changing your Admin key 

• a Users menu and a Server menu appear in your menu bar 

• User List and Server List windows appear on your screen 

The Server List window is empty because you have not yet created any 
MacX25 servers. The User List window contains the Guest user that MacX25 
Admin created when you launched the program. 

MacX25 Admin allows you to change your Admin key only when you are in 
administration mode. If you do not wish to change your Admin key, you 
can skip to the next sec.tion of this chapter. 

To change your Admin key, follow these steps: 

1. Choose Change Admin Key from the File menu. 

Figure 3-8 illustrates this choice. 

• Figure 3-8 Choosing Change Ad.min Key 
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MacX25 Admin displays the dialog box that Figure 3-9 shows. 

• Figure 3-9 Entering your current Admin key 
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Enter Rdmin Key: 

"lllllli!o!!!!lk-.. J I Cancel I 

2. Type your cuttent Admin key, and click OK. 

Type the uppercase and lowercase characters of your current Admin key. 

If you type an incorrect Admin key, MacX25 Admin displays an error 
message. Click OK. Then retype your Admin key and dick OK. 

When you enter the current Admin key correctly, MacX25 Admin displays 
the dialog box that Figure 3-10 shows. 

• Figure 3-10 Entering your new Admin key 
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Saving the Macx2; Log 

3. Type your new Admin key, and click OK. 

When you enter the new Admin key correctly, MacX25 Admin displays a 
dialog box, asking you to make sure that your new Admin key is correct. 
Figure 3-2, which appears earlier in this chapter, shows this dialog box. 

4. Click OK to verify the new Adm.in key. 

MacX25 Admin saves the new Admin key in the MacX25 Servers file. 1be 
next time that you want to put MacX25 Admin into administration 
mode, you must enter the new Admin key. 1be old Admin key will no 
longer work. 

MacX25 Admin allows you to save the contents of the MacX25 Log window 
when you are in administration mode. You can use this feature to keep a 
permanent record of the events that occur on your MacX25 gateway. 

If you do not wish to save the log information, you can skip to the next 
section of this chapter. 

To save the contents of the Log window, follow these steps: 

1. Select the MacX25 Log window by clicking anywhere inside it 

MacX25 Admin activates the MacX25 Log window. You can tell the 
window is active by the horizontal lines that appear in the window's title 
bar. 

2. Choose Save from the File menu. 

MacX25 Admin displays the dialog box that Figure 3-11 shows. 
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Making changes to the 
MacX25 gateway 

• Figure 3· 11 Naming a log file 
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3. Type a name for the new file, and click OK. 

You can give the new file any name you wish. 

MacX25 Admin creates a document file with the name you typed, and 
stores the contents of the MacX25 Log window in the new file. You 
caMot see the document file while you are using Ma005 Admin. You 
can double-dick on the file icon to open the file, if the TeachText 
application is available, or you can open the document file from within a 
word processor application, such as MacWrite. 

When MacX25 Admin is in administration mode, you can make changes to 
the MacX25 gateway. 

You can make changes to the MacX25 Servers file by following the 
instructions in Chapter 4. You can make changes to the MacX25 Users file by 
following the instructions in Chapter 5. Chapter 6 contains instructions for 
modifying the MacX25 parameter files. Chapter 7tells you how to build and 
maintain the Master Address Book. 

Al this point, you may prefer to skip to Chapter 4 and begin creating MacX25 
servers for your gateway, or you can continue reading this chapter to learn 
more about MacX25 Admin's information mode options. 
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Returning to information mode 

To protect your gateway, you should always return MacX25 Admin to its 
information mode when you are not performing administrative tasks. 

To return to information mode, select Quit Admin from the File menu, as 
Figure 3-12 illustrates. 

• Figure 3-12 Quitting administration mode 

Open Parameter File... 880 
t: lose~ :)(:UJ 

Saue 885 

Open Master Address Boole ... 

Show Log 
Change Rdmin Key 

·---·--·-............ . 
Quit Rdmin ~O 

Quitting MacX25 Admin 

After you start the MacX25 servers in your gateway, you should quit MacX25 
Admin only to perform certain maintenance tasks, such as putting a new 
parameter file into effect, adding another card to the Macintosh, or 
upgrading the system. 
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MaciC25 Admin provides the Quit option under the File menu, as Figure 3-13 
illustrates. 

• Figure 3-13 Quitting Maci'25 Admin 

Protecting the MacX25 gateway files 

To protect your gateway, you should periodically copy your MaciC25 Folder 
to a 3.5-inch disk. Then, if something happens to this folder or to any of the 
files that il contains, you can easily replace them. 
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Creating and managing MacX25 
servers 

w ITH MACX25 AOML', YOU CAN EASILY CREAIT AND MANAGE MACX2S 

servers for your MacX25 gateway. 

This chapter gives instructions for creating MacX25 servers, for starting· and 

stopping the MacX25 servers, for modifying MacX25 server information, and 

for deleting servers from the MacX25 gateway. 

You must put MacX25 Admin into its administration mode before you can 

perform any of the tasks that this chapter describes. Chapter 3 discusses 

MacX25 Admin's two operating modes and contains instructions for putting 

MacX25 Admin into administration mode. 



Creating a new MacX25 server 

To create a new MacX25 server, follow these steps: 

1. Choose Create Server from the Server menu, as Figure 4-1 shows. 

• Figure 4-1 Creating a new server 

Serm~r Info ... 
Del<~1<~ S•~ruN 

Stort 
Stot> 

Seruer List 

MacX25 Admin displays a new server information window, which Figure 
4-2 shows. The cursor appears in the text box labeled Name. 

+ You can undo the changes that you make to a server information 
window at any time before you save the window by clicking Undo. 
When you click Undo, MacX25 Admin displays a new server 
information window. 
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• Figure 4-2 A sample new server information window 

Seruer: 

AutoStart:O [Select Parameter File J 

Slot Assignm•nt ----------..., 

~~[l[I 
~ 
~Slot• 
~ 

Status: 
1 2 3 4 s 15 

Hardwar•: 

Softwar•: 

( Undo 

2. Type in the name that you want to give to the new server. 

You can enter up to 31 characters for the name. MacX25 Admin ignores 
any space characters that you type before or after the name. You can, 
however, include space characters within the name. 

3. Click Select to see a list of the available parameter files. 

MacX25 Admin displays a standard file window like the one in Figure 4-3. 
The window contains a list of the X.25 parameter files in the MacX25 
Folder. 

•:• MacX25 provides parameter files for several widely used X.25 public 
networks, one of which should fit your X.25 requirements. 
Appendix B contains tables that show the individual parameter 
settings in each of the X.25 parameter files that MacX25 provides. 

If none of the existing parameter files is appropriate for the MacX25 
server you are creating, you can make a new parameter file by following 
the instructions in Chapter 6. 
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a Figure 4-3 Selecting the parameter file for a server 

Select a Parameter Fiie for seruer. 

Rpple..OCLto_OTE 
Rpple..OTLto_OCE 
DCE Telenet 

GEl$_45HH 
Telenet Dial Out 
TeleneLOlal_Out 
Transpac DTE 

Open 

Cancel 

4. Click the name of the parameter ftle that you want the server to 
use, and click OK. 

MacX25 Admin displays the chosen name on the line that appears after 
the Parameter File label. 

You can now continue with steps 5 and 6, or you can skip to step 7. 

5. Indicate in the check box whether you want MacX25 AdmJn to 
automatically start this server each time you launch MacX25 
Admin. 

If the Auto Start check box is empty, you start the server by choosing 
Start from the Server menu. If the check box contains an X, the server 
automatically starts each time you launch the MacX25 Admin program. 

Typically, you should not specify Auto Start for a MacX25 server when 
you first create it. 

6. Click the slot to which you want to assign the MacX25 server. 

MacX25 Admin does not require you to assign a MacX25 server to a slot. 
If you want to create a server without a slot assignment, skip to step 7. 
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•!• You can create up to 20 MacX25 servers if some of the servers do not 
have slot assignments. 

You can select only a slot that is available. Figure 4-4 shows a Slot 
A5.signment box with two available slots. In the figure, slots 3 and 4 are 
available; slots 1, 2, 5, and 6 do not contain Apple Serial NuBus cards. 

• Figure 4-4 How available slots appear 

::::1~,'". c#d) ~~~n--~~1nTff ··1 

A.'111able 1lo1 -----. ....... l..;..1 .. --... -+-~ U 1....1 1....I 
, 2 3 4 s 6 

H<irdv<ir•: 

Softv<ir•: 

~ 
~Slot• 

~ 

St<itus: 

MacX25 Admin highlights the selected slot and changes its fill-pattern, as 
Figure 4-5 illustrates. The Slot A5.signment box shows the slot number, 
the type of card that resides in the slot, and the version of MacX25 
software that the server uses. 

• Figure 4-5 Assigning the slot 

Slot Assi9nm•nt --------~ 

~~ 
1 2 3 4 s 6 

~ 
~Slot• 4 
!=1111111 

Sbtus: 

H41rdv<ir•: Livonia MCP2.0d0 

Softv41r•: MacX25 

•> You can click a selected slot to deselee1 it. When you deselect a slot in this 
manner, the fill-panern and highlighting of the slot changes so that the 
slot appears available. You can then select another available slot for the 
server. 

7. Click Save. 
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+ If the name of the new MacX25 server is already assigned to another 
server in your MacX25 gateway, MacX25 Admin displays an alert box 
when you dick Save. In thi.5 case, click OK to close the alert box, 
select and edit the name, and click Save again. 

MacX25 Admin saves the server information in the MacX25 Servers file. 
The information window now shows a status of active for the server: 
The Save button i.5 dimmed and you cannot use it. Figure 4-6 shows a -
typical server information window after you save it. 

• Figure 4~ Saved server information with slot assignment 

Seruer:CorporateNet 

.) N.am•=l .... F_or_por_•t_.,._•_t -----­

P••m•t•r Fil•: DTE T•J.n•t 
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i .. 1 i .... i n 1 .. :- r; r""1 ~ 

I IUul.UU ::: • 
1 2 3 4 s 6 

Hll'dv••: Livon~ MCP2 .OdO 

Softw<ar•: MacX2!5 

Undo 

If the MacX25 server has a slot assignment, you can now start the server. 

If you prefer, you can create another MacX25 server without closing the 
previously saved server's information window. MacX25 Admin can display 
up to 10 server information windows on your screen. 
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Selecting a server 

You must select a server to start or stop it, to mcxiify its information, or to 
delete it from the MacX25 gateway. 

You can select a MacX25 server in either of the following ways. 

• by clicking the server's name in the Server List window 

• by activating the server's information window 

The MacX25 Server List window lists all of the MacX25 servers in the MacX25 
gateway. 

MacX25 Admin automatically displays the MacX25 Server List window when 
you enter its administration mcxie. If you close this window, you can get 
MacX25 Admin to display it again by choosing the Server List command from 
the Server menu. Figure 4-7 shows the Server menu with the Server List 
command highlighted. 

• Figure 4-7 Displaying the MacX25 Server List window 

Create Server 31:R 
Server Info ... 
Delete Server 

'>tart 
'>top 

Serner li\t 

Figure 4-8 contains an example of the MacX25 Server List window for a 
MacX25 gateway with three MacX25 servers. In the figure, two of the 
MacX25 servers are assigned to slots in the MacX25 gateway; the other 
MacX25 server is not assigned to any particular slot. 

You can select any of the servers in the list by clicking anywhere on the line 
that contains the server name. 
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• Figure 4-8 
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Activating a server 
information window 

A sample MacJC25 Server List window 
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When you click on a name in the MaciC25 Server List window, MaciC25 Admin 
provides commands under the Server menu that are appropriate to the server. 
For example, if the highlighted server is not assigned to a slot, you can use 
the Server Info or Delete Server commands from the Server menu. If the 
server is ready to start, you can use the Server Info, Delete Server, or Start 
commands. If you select a server that is active or busy, you can use the 
Server Info or Stop commands. You can find specific instructions for using 
these commands later in this chapter. 

You can activate a MacX25 server's information window in any of the 
following ways: 

• by selecting the server from the list of servers in the MacX25 Server List 
window and then choosing Server Info from the Server menu 

• by double-clicking the server's name in the MacX25 Server List window 

• by clicking on the information window of the server that you want to 
activate 

• by double-clicking the server's slot from any server information window 

When you activate a MaciC25 server's information window, MaciC25 Admin 
brings the window to the front of your display and provides commands 
under the Server menu which are appropriate to that server. 
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Starting a MacX25 server 

You can start only a server that is ready. A server is ready after you save the 
contents of its information window, as described earlier in this chapter. 

To start a server: 

1. Select the server. 

2. Choose Start from the Server menu. 

The Start command includes the name of the selected server, as Figure 4-
9 shows. 

• Figure 4-9 Staning a MacX25 server 

s File Edit Users 
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.. iii®'®'"' 4 

3 

Seruer List 

MacX25 Admin starts the server. 

+ If the name of the new MacX25 server is already assigned to another 
device or server in the AppleTalk network system, MacX25 Admin 
displays an alert box. In this case, click OK to close the alert box, and 
rename the server. You can find instructions for renaming the server · 
later in this chapter. 

When the server starts, its status changes from ready to active. You can 
see this change in the status column of the Server List window and in the 
slot information box of the server information window. MacX25 Admin 
changes both the slot's fill-pattern and the status in the Slot Assignment 
box. Figure 4-10 shows how the slot information box appears after the 
MacX25 server is started. 
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• Figure 4-10 Slot 4 as active 
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When a server is active, users can connect to the server to make and 
receive calls through the X.25 network that the server supports. When a 
user has a virtual call on the server, the status of the server changes to 
busy. Figure 4-11 shows how the slot information box appears when 
the MaciC25 server is busy. 

• Figure 4-11 Slot 4 as busy 
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Stopping a MacX25 server 

You can stop only a MacX25 server that is active or busy. To stop a server: 

1. Select the server. 

2. Choose Stop from the Server menu. 

The command includes the name of the selected server, as Figure 4-12 
shows. 

• Figure 4-12 Choosing Stop from the Server menu 
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MacX25 Admin displays a MacX25 Stop window. Figure 4-13 has an 
example of this window. 

• Figure 4-13 A sample MacX25 stop window 

Shutdown 
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Pending stops 

3. Enter the number of minutes that you want MacX2S Adm.in to wait 
before stopping the indicated server, and click OK. 

You can enter any number from zero to 9999 in the text edit box. If you 
don't change the zero in the text edit box, MacX25 Admin stops the server 
immediately after you click OK. 

You can specify a pending stop for the server by entering any number 
other than zero. For example, to specify a pending stop of one hour, you 
type 60 in the text box. To specify four hours, you type 240. To specify 
24 hours, you enter 1440 in the text box. Figure 4-14 shows a MacX25 
Stop window for a one-hour pending stop of the CorporateNet server. 

• Figure 4-14 A sample MacX25 stop window 

Shutdown 
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Numb•r of minut•s until shutdown? 

H OK m I Cancel 

When you set a pending stop, MacX25 Admin continues to display the 
MacX25 Stop window until the stop occurs or you cancel the pending stop. 
The text box shows the number of minutes that remain before MacX25 
Admin will stop the server. If any users are connected to the server, MacX25 
Admin periodically notifies them of the pending stop. 

If you set a pending stop for more than one MacX25 server, a separate 
MacX25 Stop window appears for each server with a pending stop. 

When you set a pending stop for an active or busy slot, MacX25 Admin 
changes the appearance of the slot, as Figure 4-15 illustrates. 
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• Figure 4- lS How a slot with a pending stop appears 
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Pending stop windows appear while MacX25 Admin is in administration 
mcxle or in information mcxle. You cannot close a MaCX.25 Stop window 
without cancelling the stop; and you can cancel a stop only when MacX25 
Admin is in administration mcxle. 

Modifying MacX25 servers 

You perform all information changes to a MaCX.25 server by using its server 
information window. This section describes the changes that you can make 
to a MaCX.25 server and provides instructions for making the changes. 

<- You can undo the changes that you make to a server information 
window at any time before you save the window by clicking Undo. 
When you click Undo, the server information window displays the most 
recently saved information on that server. 

You can rename only a MacX25 server that is currently ready to start. If the 
server is active or busy, you must stop the server before you can rename it. 

To rename a server, follow these steps: 

1. Activate the server information window of the server that you 
wish to rename. 

2. Select the current name of the server. 
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Changing the server's 
parameter file 

3. Type in the new name that you want to give to the server. 

You can enter up to 31 characters for the name. The name that you enter 
must be unique to the Mae){25 gateway and to the AppleTalk network. 

4. Click Save. 

Mae){25 Admin saves the new name of the server. 

When you rename a Mae){25 server, you must change the server information 
in each Master Address Book entry that uses that server. 6. 

You can specify a different parameter file for a MacX25 server at any time. 
Mae){25 Admin does not begin using the new parameters, however, until you 
restart the MacX25 server. 

To change the parameter file that a server uses, follow these steps: 

1. Activate the server information window of the server that you 
wish to change. 

2. Click the Select Parameter File button. 

MacX25 Admin displays a dialog box that lists the available parameter 
files. 

3. Double-click the name of the parameter me that you want the 
server to use. 

Mae){25 Admin displays the chosen name on the line that appears after 
the Parameter File label. 

4. Click Save. 

MacX25 Admin saves the new information in its Mae){25 Servers file. 

If none of the existing parameter files is appropriate for the MacX25 server, 
you can make a new parameter me by following the instructions in 
Chapter6. 
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setting 

Changing the slot 
assignment 
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You may prefer to manually start a MacX25 server when you create or 
modify it, and then change the automatic startup setting after you can 
verify that the MacX25 server i.5 working properly. 

To change the automatic startup setting for a server, follow these steps: 

1. Activate the server information window of the server that you 
wish to change. 

2. Indicate in the Auto Start check box whether you want MacX25 
Admin to automatically start this server each time you open 
MacX25 Admin. 

If the Auto Start check box is empty, you start the server by choosing 
Start from the Server menu. If the check box contains an X, the server 
automatically starts each time you launch the MacX25 Admin program. 

3. Click Save. 

MacX25 Admin saves the server information in the MacX25 Servers file. 

The new setting takes effect the next time you launch MacX25 Admin. 

You can change the slot assignment of a server only when the server is ready 
or is not assigned to a slot. 

To change the slot assignment of a server, follow these steps: 

I. Activate the server information window of the server that you 
wish to change. 

2. Click the slot to which you want to assign the MacX25 server. 

MacX25 Admin highlights the selected slot and changes its fill-pattern, as 
Figure 4-5 illustrates earlier in this chapter. The Slot Assignment box 
shows the slot number, the type of card that resides in the slot, the 
current status of the MacX25 software, and the version of MacX25 
software that the server uses. 
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+ You can click a selected slot to deselect it. When you deselect a slot in this 
manner, the fill-pattern and highlighting of the slot changes so that the 
slot appears available. You can then select another available slot for the 
server. 

3. Click Save. 

MacX25 Admin saves the new slot assignment in the MacX25 Servers file. 
Slot assignment changes take effect immediately. 

Deleting a MacX25 server 

You can delete a MacX25 server only when the server is ready or is not 
assigned to a slot. 

To delete a server from your MacX25 gateway, follow these steps: 

1. Select the server that you wish to delete. 

2. Choose Delete Server from the Server menu. 

The Delete command includes the name of the selected MacX25 server, as 
Figure 4-16 illustrates. 

• Figure 4-16 Choosing Delete from the Server menu 

Seruer List 

MacX25 Admin displays the alert box that Figure 4-17 shows. 
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• Figure 4-17 Deleting a server from the MacX25 gateway 

Rre you sure you want to delete 

CorporateNet 

Cancel OK 

3. Click OK. 

When you delele a MacX25 server, MacX25 Admin deleles all of the server's 
informalion from the MacX25 Servers file. After you delete a MacX25 server, 
iLS name does not appear in the Server List window and you can not gain 
access to iLS server information window. 
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Setting user access to MacX25 servers 

You CAN PROVIDE SECURITY FOR THE SERVERS L"I YOUR MACX25 GATEWAY BY 

seuing server access privileges for each MacJC25 user. MacJC25 Admin can 

support up to 500 users with individually specified access privileges. 

This chapter contains instructions for creating MacX25 users, for modifying 

the information of existing users, and for deleting users from the gateway. 

You must put MacX25 Admin into administration mode before you can 

perform any of the tasks that this chapter describes. Chapter 3 discusses 

MacX25 Admin's two operating modes and contains instructions for putting 

MacX25 Admin into administration mode. 

55 



Providing security for MacX25 servers 

When a user on the AppleTalk network chooses a MacX25 server from the 
Choo;er desk accessory or attempts to place an X.25 call using an address 
00ok entry, MacX25 Admin displays a dialog box, similar to the one that 
Figure 5-1 shows. 

• Figure 5-1 Providing secured access to MacX25 servers 

~ 
Connect to the H.25 Seruer "CorporateNet" as: 

0 Cit)(~~t 

® Registered User 

Name: I 
:====:::::;;---~~~~~---

Password: .... I __ __, (Scrambled) 

Cancel (Set Password ) f( OK J 
1.0d8 

To gain access to the server, the user must enter a name and password that 
matches user information that you have previously saved. If the user enters 
infonnation that MacX25 Admin can match, MacX25 Admin allows the 
connection. If the user enters information that MacX25 Admin cannot 
match, MacX25 Admin does not allow the connection. 
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Although MacX25 Admin automatically creates a Guest user when you first 
launch the program, it does not automatically set access privileges to any 
MacX25 servers for the Guest user. For this reason, the Guest option in the 
figure is dimmed. After you change the Guest information to give guest 
access to the server, Guest is not dimmed when a user sees the dialog box 
after selecting that server. 

MacX25 Admin allows you to control whether or not a user can change the 
password. If you enable the change password privilege for a user, the user 
can click the Set Password button to make the change. If you disable the 
change password privilege for a user, the Set Password button appears 
dimmed. 

Creating a new user 

To create a new user for the MacX25 gateway, follow these steps: 

1. Choose Create User from the Users menu, as Figure 5-2 shows. 

• Figure 5-2 Creating a new user 

Delete User ... 
User Info .•. 

User List 

MacX25 Admin displays a new user information window. Figure 5-3 
shows an example of the new user information window. The cursor 
appears at the beginning of the name field so that you can enter the name 
first. 
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• Figure S-3 A new user information window 
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+ You can undo the changes that you make to a user info~tion 
window at any time before you save the window by clicking Undo. 
When you click Undo, Mae}{25 Admin displays a new user 
information window. 

2. Type the name that you want to give to the new user. 

You can enter up to 31 characters for the name. MacX25 Admin ignores 
any space characters that you type before or after the name. You can, 
however, include space characters within the name. 

3. Type a password for the user. 

You can enter up to 8 characters for the password. You can see the 
characters as you type them, as Figure 5-4 shows; but when you save the 
user information, MacX25 Admin changes each character to a •. In this 
way, the password is masked and remains private to the user. 
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• Figure 5-4 Entering user information 
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4. Indicate in the check box that appears after Change Password 

Enabled whether you want the user to be able to change the 
~ord. 

If the Change Password Enabled check box contains an X, the user can 
change the password by using the Set Password button on the dialog box 
that Ftgure 5-1 shows. If this check box is empty, the Set Password 
buuon on that dialog box is dimmed. 

5. Indicate in the check box next to each server name whether you 
want the user to have access to that server. 

Each Mac)(25 server with saved information appears in the list, whether 
or not the server is assigned to a slot. A check box appears to the right of 
the server name. 

If the check box contains an X, the user can gain access to the server. If 
the check box is empty, the user cannot gain access to the server. 

6. Click Save. 
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MacX25 Admin saves the user information in the MacX25 User's file. 
Figure 5-5 shows a saved user inf orrnation window. In the figure, the 
password is masked, the user can change the password remotely, and the 
user has access to bolh Mae){25 servers in the list. 

+ If the name of the new Mae){25 user is already assigned to an existing 
user in your MacX25 gateway, MacX25 Admin displays an alert box 
when you dick Save. In th~ case, click OK to close the alert box, 
select and edit the name, and click Save again. 

• Figure S-S Saved user information 

ID User:Rn~ Richard 

D Name: lli1.nd11 Richwd I 
P assvorll: I •••••••• I 

Cha"9• P aSS'W'Or"d En ab l•d : l8l 
Login Access : "'f Corporat•N•t 181 ~ 

"'f R & D ~t 181 
"'f' Transpac 0 

IQ 
I Un th> l ~ S<lll<~ 

, 
The user can now connect to any of the MacX25 servers to which you gave 
the user access privileges in step 5 .. 

If you pref er, you can create another Mae){25 user without closing the 
previously saved user's information window. MacX25 Admin can display up 
to 10 user information windows on your screen. 
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Selecting a user 

You must select a user to modify the information on that user or to delete 
the user from the MacX25 Users ftle. You can select a MacX25 user in either 
of the following ways: 

• by clicking the user name in the MacX25 User List window 

• by activating the user information window of the user you want to 
select 

MacX25 Admin provides a MacX25 User List window that lists all of the users 
in its MacX25 Users file. MacX25 Admin automatically displays the MacX25 
User List window when you enter its administration mode. If you close this 
window, you can get MacX25 Admin to display the window again by 
choosing the User List command from the Users menu. Figure 5-6 shows 
the Users menu with the User List command highlighted. 

• Figure S-6 Displaying the MacX25 User List window 

create user... KU 
Delete User ••• 
User Info ••• 

u~e• La~t 

Figure 5-7 contains an example of the MacX25 User List window. You can 
select any of the users in the list by clicking the user's name. 
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Activating the user 
information window 

• Figure S-7 A sample MacX25 User List window 

MacH25 User List 

Name 

Q <Guest> 

U Midy Rich¥d 

Q Barbar a Spencer 

Q Dave Robertson 

Q J()IJ ce Clark 

Q P ;it Johnson 

Q Susan 'w'an 

t--

When you select a name in the MacX25 User List window, you can use the 
Delete User command to delete the user from the gateway or you can ·use 
the User Info command to display the user's information window so that 
you can modify its contents. Both of these commands appear under the 
Users menu. 

You can activate a user's information window in any of the following ways: 

• by selecting the user name in the MacX25 User List window and then 
choosing User Info from the Users menu 

• by double-clicking the user name in the MacX25 User List window 

• by clicking on the inactive information window of the user 

When you activate a user's information window, MacX25 Admin brings the 
window to the front of your display and provides commands under the 
Users menu that are appropriate to the user. 
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Changing existing users 

This section describes the changes that you can make to a user and provides 
instructions for making the changes. Unlike changes to server infonnation, 
all changes to a user's information take effect immediately after you save 
the changes. 

•> You can undo the changes that you make to a user information window 
at any time before you save the window by clicking Undo. When you 
click Undo, the user information window displays the most recently 
saved information on that user. 

Occasionally a user requires a name change. To rename a user, follow these 
steps: 

1. Activate the user information window of the user whose name 
you wish to change. 

2. Select the current user name, and type the new name. 

You can enter up to 31 characters for the name. MacJC25 Admin ignores 
any space characters that you type before or after the name. You can, 
however, include space characters within the name. 

3. Click Save. 

If you enter a name that is already assigned to another user in the MacX25 
gateway, MacX25 Admin displays an alert box. In this case, click OK to 
close the alert box. Then enter a variation that makes the name unique. 

You can change a user's password at any time. To do so, follow these steps: 

1. Activate the user information window of the user whose 
password you wish to change. 

2. Select the current p~ord , and then type the new p~ord. 

You can enter up to 8 characters for the password. You can see the 
characters as you type them. 
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Modifying the Change 
Password Enabled setting 

Changing a user's server 
access privileges 

3. Click Save. 

MacJC25 Admin saves the change, and masks the new password, as Figure 
5-5 shows, so the password is private to the user. 

To modify the Change Password Enabled setting for a user, follow these 
steps: 

1. Activate the user information window of the user whose setting 
you wish to change. 

2. Indicate in the Change Password Enabled check box whether you 
want the user to be able to change the password. 

If the Change Password Enabled check box contains an X, the user can 
change the password by using the Set Password button on the dialog box 
that Figure 5-1 shows. If this check box is empty, the Set Password 
button in this dialog box is dimmed. 

3. Click Save. 

Before Mae}{25 Admin will allow guest users to gain acces.s to a server, you 
must change this setting in the Guest user information window. 

You can change a user's access privileges to any server at any time. To 
change a user's access privileges for one or more MacX25 servers, follow these 
steps: 

1. Activate the user information window of the user whose setting 
you wish to change. 

2. Indicate in the check box next to each server whether you want the 
user to be able to use that server. 

Each MacX25 server with saved information appears in the list, whether 
or not the server is assigned to a slot. A check box appears to the right of 
the server name. If the check box contains an X, the user can gain access 
to the server. If the check box is empty, the user cannot gain access to 
the server. 

3. Click Save. 
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Deleting a user 

To delete all of the information on a user, follow these steps: 

1. Select the user that you wish to delete. 

2. Choose Delete User from the Users menu. 

Figure 5-8 illustrates the Users menu with the Delete User command 
highlighted. 

• Figure S-8 Deleting a user from the gateway 

User List 

MacX25 Admin displays an alert box, like the one in Figure 5-9. 

• Figure 5-9 Deleting a user from the gateway 

Rre you sure you wont to delete 

Rndy Richord 

Concel ] OK 

3. Click OK. 

MacX25 Admin deletes the user information from the MacX25 Users file 
and removes the user name from the MacX25 User List window. 
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C H A P T E R 6 

Setting X.25 Parameters 

THE MACX25 PRODUCT PROVIDF.S PARAMETER FILES TilAT CONTAIN TIIE CORRECT 

X.25 parameter settings for several commonly used public packet-switched 

data networks. The name of the file indicates the network vendor that uses 

the X.25 parameter settings in the file. 

This chapter contains instructions for opening a parameter file, for displaying 

and modifying specific settings, and for saving the changes. 

You must be in MacX25 Admin's administration mode to perform the tasks 

described in this chapter. You can find instructions for putting MacX25 

Admin into administration mode in Chapter 3. 
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About X.25 parameters 

When you subscribe to services from a packet-switched data network, you 
must negotiate with the network vendor on approximately 150 X25 
parameters for your particular situation. The network vendor usually tells 
you what setting to use for each of the X25 parameters. Once you 
determine these parameter settings, you must incorporate them into your 
X.25 software. 

If MacX25 provides a parameter file for the packet-switched data network 
to which your MacX25 server connects, your MacX25 server can use that 
parameter file with few, if any, modifications. 

If you are using a private or public packet-switched data network for which 
there is no existing MacX25 parameter file, you can refer to Appendix B to 
determine the parameter file that most closely matches your requirements. 
F.ach table in Appendix B shows the 31 parameters that you can dynamically 
set with MacX25 Admin, along with the parameter settings that you cannot 
change. 

6 Important Do not remove the parameter files from the MacX25 Folder. MacX25 Admin 
uses only the fdes in the MacX25 Folder, and does not provide a command to 
create an empty parameter fde. You must use an existing parameter file to 
create a new parameter file for your MacX25 server. 6. 

If you need to modify a parameter that you cannot change with MacX25 
Admin, you should contact your Apple Techni~l Support representative for 
assistance. 

Opening a parameter file 

Follow these instructions to open a parameter file: 
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1. Choose Open Parameter File from the File menu. 

Figure 6-1 shows the File menu with the Open Parameter File command 
highlighted. 

• Figure 6-1 Choosing Open Parameter File from the File menu 

t:tose ~(:UJ 

Sa Pe es 
S<n•<~ fl~ ... 
lh~IJN t 

Open Master Address Book ... 

Show Log 
Change Admin Key 

Quit Admin 

MacX25 Admin displays a dialog box listing all of the parameter files in the 
MacX25 Folder. Figure 6-2 shows an example of this dialog box. 

• Figure 6-2 Selecting the parameter file to open 

Select a Parameter File for editing. 

DCE Telenet 

Open 

Transpac DTE Cancel 
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2. Open the parameter file that you want to see. 

To open the file, you can double-click its name in the Ii.st or you can select 
the fdename and dick Open. 

MacJC25 Admin displays the parameter file window showing the settings 
for the Addressing parameter group. Figure 6-3 illustrates the parameter 
file window. 

• Figure 6-3 The parameter file window 

TeleneLDiaLOut 

Uaed 89: C.mmeats 
~1 -----------.~"T-1 -De-t-eu_lt_X-.2-5-Co_n_fi_gu-ra-ti-on_f_il_e_fu_r~ 

~ - bl T•le"" Dlel•Out Opmtio" 

Rddressin 

Line Type ----. 

®DTE 0 DCE 

Frame & Packet 

User &roups ----------, 

CUG: I None! 

BCUG 0 Yes ® No 

rCCllT Compotlblllty l 
Network ID ~ L ® 1980 O 1984 _ 

The name of the file appears in the title bar of the window. The Used By 
Ii.st box shows all of the MacJC25 servers that use the parameter file. The 
Comment text box contains a brief note about the current parameter file. 
The lower portion of the window shows the current setting of each 
parameter in the Addressing parameter group. 

If you wish to edit the current comment, do step 3. Otherwi.se, you can 
begin viewing the parameter groups and making changes to the settings 
as needed. 
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3. Edit the text in the Comment box. 

You can edit the text in the Comment box by highlighting the characters 
that you wish to change and typing the new information. 

If you type more text than the window can display, you can scroll up the 
text by highlighting the text at the top and dragging your mouse up; you 
can scroll down the text by highlighting the text at the batom and 
dragging your mouse down. 

You can now begin working with the parameter groups. 

With MacX25 Admin, you can have several open MacX25 parameter mes on 
your screen. If you are viewing more than one parameter ftle, only one 
parameter file window is active. 

Working with parameter groups 

MacX25 Admin groups the X.25 parameters whose settings you can change 
into the following parameter groups: 

• Addressing parameters 

• Channel Allocation parameters 

• Charging options 

• Frame Level parameters 

• Packet and Window Siz.e parameters 

• Timers 

This section contains instructions for viewing and making changes to the 
current parameter settings of each parameter group. 

You can find a brief description of each of the parameters in Appendix C of 
this guide. Contact your packet-switched data network vendor for more 
detailed descriptions and for specific setting information. 

This section contains instructions for viewing and making changes to the 
Addressing parameter settings. lf you are already viewing Addressing 
parameters, you can skip step 1. 
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To work with the Addressing parameters, follow these instructions: 

L Select Addressing from the pop-up menu under the parameter file 
icon. 

Ftgure 6-4 shows this pop-up menu with Addressing highlighted. Figure 
6-3 illustrates how Addressing parameters appear in the window. 

• Figure 6-4 Choosing the Addressing parameter group 

..-'Addr e~~ing 
Charging 
Channel Rllocatlon 
Frame Leuel 
Packet & Window Size 
Timers 

2. Indicate whether the MacX2S server acts as data terminal 
equipment (DTE) or as data communications equipment (DCE). 

If the DTE radio button contains a dot, the Mae}{25 server acts as a DTE. 
If the DCE radio button contains a dot, the Mae}{25 server acts as a DCE. / 

3, Specify the full Network ID for the MacX2S server. 

The first four digits of the Network ID uniquely identifies the packet­
switched data network. For example, the four-digit ID for Telenet is 3110 
hexadecimal (hex). 

The remaining digits uniquely identify the Mae}{25 server on the packet­
switched data network. The network vendor assigns this address and 
uses it to deliver packets to the MacX25 server. 

4. Select from the CUG pop-up menu the closed user group 
subsaiption that the MacX2S server uses. 

Figure 6-5 shows the dnsed user group options as they appear in the 
CUG pop-up menu. 
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• Figure 6-S Closed user group options 

User Groups 

CUG None 

BCUG IR/OR without preferentiol 
OR without preferential 
IR without preferential 
IR/OR with preferential 
OR with preferential 
IR with preferential 
with preferential 

s. Indicate whether your MacX25 server has a bilateral closed user 
group (BCTJG) subscription. 

If the Yes radio button contains a dot, the MacX25 server has a bilateral 
closed user group subscription. If the No radio button contains a dot, 
the MacX25 server does not have a bilateral closed user group 
subscription. 

A logical channel number (LCN) is a value that uniquely identifies each virtual 
circuit on the X.25 link. 

When the MacX25 server acts as the DTE, it assigns the LCN for each 
outgoing call, whether the call uses a two-way channel or an outgoing (only) 
channel. When the MacX25 server acts as the DCE, it assigns the LCN for each 
incoming call, whether the call uses a two-way channel or an incoming (only) 
channel. The MacX25 server's Channel Allocation settings must match the 
channel allocation settings that the network uses. 

To view the current Channel Allocation settings, follow this instruction: 

Choose Channel Allocation from the pop-up menu under the 
parameter file icon, as Figure 6-6 shows. 
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• FJgure 6-6 Choosing the Channel Allocation parameter group 

Frame Leuel 
Packet & Window Size 
Timers 

MaciC25 Admin displays the Channel Allocation settings, as Figure 6-7 
shows. 

• FJgure 6-7 Channel Allocation parameters 

ID Telenet_DiaLOut 

Used 811: Comments 

~ I ____________________ ~- -~-f-e-ul-tX-.2-5_C_o-nf-ig-u-re-ti-on-F-il_e_ro_r_, 
~ - ~ Tolonet Dtol·O't Opontio"' 

Channel Rlloc8tion 

Low High Qu8ntity 

O Outgoing Channels: __ fi} __ fi} 
l:l:?J Two-Way Channels: __ 1 fil 64 64 fil __ + 

O Incoming Channels: __ i;i __ i;i 

Used 64 

MaHimum 64 
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How you change Channel Allocation settin~ 

Mac){25 Admin allows you to allocate up to 64 logical channel numbers 
among the three types of channels that MacX25 supports. Figure 6- 7 shows 
the supported channel types, which include outgoing channels, two-way 
channels, and incoming channels. 

+ MacX25 does not support permanent virtual circuits (PVCs); so you 
cannot allocate any PVC channels. 

A check box precedes each type of channel. The check box indicates whether 
the MacX25 server uses this type of channel. If the check box contains an X, 
you must specify at least one LCN for that channel type. If the check box is 
empty, you cannot allocate any channels of that type. 

You use the arrow controls that appear under Low to increase or decrease the 
lowest LCN for the channel type. The arrow pointing up increases the LCN; 
the arrow pointing down decreases the LCN. 

You use the arrow controls that appear under Quantity to increase or 
decrease the total number of channel numbers for the channel type. 

MacX25 Adrnin does not allow you to overlap the range of any two channel 
types or to specify a range out of the required order. 

Sample instructions 

To demonstrate how this works, the following procedure describes how 
you can change the Channel Allocation settings in Figure 6- 7, which shows 
all 64 LCNs allocated to two-way channels, to the following settings: 

10 incoming channels with LCNs of 1through10 

50 two-way channels with LCNs of 200 through 249 

4 outgoing channels with LCNs of 250 through 253. 

1. Use the arrow pointing down that appears next to 64 to decrease 
the number of LCNs for two-way channe~ to 50. 

MacX25 Admin decreases the quantity, adjusts the value of the highest 
two-way LCN, and adjusts the number of Used channels, as Figure 6-8 
shows. 

You now have 14 available LCNs that you can allocate to another type of 
channel. 
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• Figure 6-8 Providing available channels 

Channel Allocation 

Low High Quantity 

O Outgoing Channels: _r;J _r;J 
~Two-Way Channels: ____! r;J 50 ~r;J 
O Incoming Channels: __ r;J _r;J 

Used 50 

MeHimum 64 

2. Use the arrow pointing up that appears next to 1 to increase the 
lowest logical channel number for two-way channels to 200. 

If you hold your mouse down on the arrow, MacX25 increases the value 
by ones, then by tens, then by one-hundreds. MacX25 Admin allows you / 
specify LCNs up to 4096. 
You can now allocate incoming channels. 

3. Click the Incoming Cbannek check box. 

MacX25 Admin sets the lowest LCN for Incoming channels to 1, 
calculates the total incoming channels from the available LCNs, and 
displays the new High, Quantity, and Used values. 

Figure 6-9 illustrates how the Channel Allocation parameter box appears 
after you perform steps 2 and 3. 
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• Figure 6-9 Allocating incoming channels 

Channel Allocation 

Low High Quantity 

O Outgoing Channels: __ (;) __ (;) 

181 Two-Way Channels: ~(;) 249 -2.!! (;) 
181 Incoming Channels: 1 (;) --· 14 ~(;) 

Used 64 

MaHimum 64 

4. Use the arrow pointing down that appears next to 14 to decrease 
the quantity of incoming channels to ten. 

MacX25 Admin changes the quantity and adjusts the high incoming 
channel number and the number of Used channels, as Figure 6-10 shows. 

You now have 4 available LCNs that you can allocate to outgoing 
channels. 

• Figure 6-10 Decreasing the number of incoming cha:mels 

Channel Allocation 

Low High Quantity 

D outgoing Channels: -~ __ (11 

181 Two-Way Channels: ~~ 249 -2.!! (;) 
181 tncoming Channels: _1~ 10 10 (;) --· 

Used 60 

Ma Hi mum 64 
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5. Click the Outgoing ChanneJs check box. 

MacX25 Admin calculates the available number of channels, and enters the 
lowest possible LCN values for the new channels, as Figure 6-11 shows. 

• Figure 6-11 Allocating the outgoing channels 

Channel Allocation 

Low High Quantity 

181 Outgoing Channels: .....ill. [;) 253 ~~ 
181 Two-Way Channels: _ill [;) 249 ~It] 
1811 ncoming Channels: __ 1 [;) 10 ___!! It] 

Used 64 

MaHimum 64 

To view and make changes to the Charging options, follow these 
instructions: 

1. Choose Charging from the pop-up menu under the parameter file 
icon, as Figure 6-12 shows. 

• Figure 6-12 Choosing the Charging parameter group 

Channel Allocation 
Frame Leuel 
Packet & Window Size 
Timers 

MacX25 Admin displays the Charging options, as Figure 6-13 shows. 
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• Figure 6-13 Charging options 

!ID TeleneLDiaLOut ~-::::...._-==------­~=-::::...=== --~-

Usell 81J: C.mments 

~ I~~~~~~~~~~~~~ -De-~-e-ul-tX-.-25-Co~nf-ig-u-re-ti-on~fi-le_ro_r_, 
~ - Id Tolo,.I Oiol-0" "'"''""" 

Char in 

O Allow Reuerse Charging 

® Preuent Local Charging 

2. Indicate which type of Charging the MacX25 server uses. 

If the Allow Reverse Charging radio button contains a dot, a MacX25 user 
can make a connection and bill the call to the destination host. 

If the Prevent Local Charging radio button contains a dot, a remote caller 
cannot make a connection to a MacX25 user and charge the call to the 
MacX25 server. 

The Frame Level parameter group contains parameters that affect how the 
MacX25 server handles operations at the frame level. Frame Level parameters 
include window settings, frame level timer settings, and a connection mode 
specification. 

You can find information on all of the Frame Level parameters except T 4 in 
the CCITT Recommendation X.25, also known as the Redhook. The 
international Standards Organization (ISO) defines the T4 timer. 
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To view and change any of the Frame Level parameters, follow these 
instructions: 

L Choose Frame Level from the pop-up menu under the parameter 
.tlle icon, as Figure 6-14 shows. 

• Figure 6-14 Choosing the Frame Level parameter group 

Addressing 
Charging 
Channel Allocation 

Packet & Window Size 
Timers 

MacX25 Admin displays the Frame Level parameters, as Figure 6-15 
shows. 

• Figure 6-15 Frame Level parameters 

TeleneLDlaLOut 

Use~ B1: C.mments 

rlti l ________________ __.~~ -Oe1'--au-1t-X-.2-5_Co_n_flo_u_n_ti_on_f_il_e_ro_r~ 
~ - ~ Tole .. t Diel-O't """"'"' 

Frameleueli-----------------------------------­

Wlndow ------------. 

MaHimum Size __ 7 l;J 
Modulo ® 8 O 128 

Timers----------------~ 

T1 ~msec. 
T4 ~sec. 
N2 ~ Repetition C~unt 

Connection Mode I Wait for SRBMf 
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2. Indicate which numbering system, or Modulo, the MacX2S server's 
frame level software uses. 

If the 8 radio button contains a dot, the MaciC25 server uses Modulo 8. If 
the 128 radio button contains a dot, the MaciC25 server uses Modulo 128. 

3. Use the arrows to the right of Maximum Size to set the maximum 
number of frames that the server can send or receive without 
acknowledgment. 

If you click the arrow pointing up, MaciC25 Admin increases the setting; if 
you click the arrow pointing down, Macia5 Adrnin decreases the setting. 

If the Macie25 server uses Modulo 8, you can set the maximum window 
size to any value from 1 through 7. If the MaciC25 server uses Modulo 128, 
you can set the maximum window size to any value from 1 through 127. 

4. Choose the connection mode that the MacX2S server uses from the 
Connection Mode pop-up menu. 

MacX25 supports two connection modes, Wait for SABM and Send 
SABM, as Figure 6-16 shows. A SABM is a type of packet that the local 
and remote X25 frame level software exchanges to establish a new virtual 
circuit. 

If the network sends the SABM, choose Wait for SABM. If the network 
expects the MacX25 server to send the SABM, choose Send SABM. 

• Figure 6-16 Connection mode options 

r{ Frame Leuel 

r-Window r-Tlmers 

MaHimum Size 7 r;i -- + 
Tl 160 I msec. 

Modulo @8 0 128 14 ~sec. 
N2 120 I Repetition Count 

li1ln@lit.!,l#fiiil,ilbfiltdii;l:I#, 
Send SR8M 
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5. Set the value of the Tl timer, if needed. 

The Tl parameter indicates the number of 50 millisecond units that occur 
before the MacX25 server retransmits a frame. For example, if you enter 
60 in the text edit box for this parameter, you are specifying 3000 
milliseconds, or 3 seconds. 

6. Set the value of the T4 timer, if needed. 

The T4 parameter specifies how many seconds the MacX25 server waits 
for an event to occur on the line before the MacX25 server sends a 
Receiver Ready (RR) frame to the network. You can disable this timer by 
setting its value to zero. 

7. Set the value of the N2 repetition count, if needed. 

N2 is a counter. You indicate in its text edit box the maximum number of 
times that the MacX25 server can retransmit a frame under error 
conditions before the MacX25 server resets the link. 

The Packet and Window Size parameter group contains parameters that 
affect how the MacX25 server handles operations at the packet level. You 
and your network vendor must agree to these settings when you subscribe 
to the network. 

To view and change any of the Packet and Window Size parameter settings, 
follow these instructions: 

1. Select Packet & Window Size from the pop-up menu under the 
parameter file icon, as Figure 6-17 shows. 

• Figure 6-17 Choosing the Packet & Window Size parameter group 

Addressing 
Charging 
Channel Allocation 
Frame Leuel 

Timers 
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MacX25 Admin displays the Packet and Window Size parameters, as 
Figure 6-18 shows. 

• Figure 6-18 Packet and Window Size parameters 

--;:::-------~=========----===---=::= 
-- ----- ---- ---- - - - TeleneLDiaLOut 

Used BIJ: Cemme•ts 
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Packet & Window Sizei-----------------. 

Packet Window------~ 

Default Length: c::TI!J 
MaHimum Length:! 10241 

Default Size 

MaHimum Size 

Modulo ® 8 

__ 2 ~ 

__ 7 ~ 

0128 

The Packet oox contains two pop-up menus that you use to specify the 
default and maximum length of a packet that the MacX25 server can send 
or receive. Ftgure 6-19 shows the options that you can select for these 
parameters. 
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• Figure 6-19 Packet Defaul! Length and Maximum Length options 

Packet 

Default Length: 

32 
64 
128 
256 
512 

The Window box for the Packet Level parameters contains three settings: 
Default Size, Maximum Size, and Modulo. The window size determines 
the number of packets that the network can send to, or receive from, the 
MacX25 server without confirmation. 

2. Choose the packet length that the MacX2S server normally uses 
from the Default Length pop-up menu. 

You can choose a default packet length of 32, 64, 128, 256, 512, 1024, 2048, or 
4096. If any of these options are dimmed in the pop-up menu, you 
cannot choo.5e the option. 

3. Choose the largest packet length that the MacX25 server can send 
or receive from the Maximum Length pop-up menu. 

You can choose a maximum packet length of 32, 64, 128, 256, 512, 1024, 
2048, or 4096. If any of these options are dimmed in the pop-up menu, 
you cannot choose the option. 

4. Indicate which numbering system, or Modulo, the MacX25 server's 
packet levd software uses. 

If the 8 radio button contains a dot, the MacX25 server uses Modulo 8. If 
the 128 radio button contains a dot, the MacX25 server uses Modulo 128. 
Figure 6-20 shows an example of the Window box for a MacX25 server 
that uses Modulo 128. 
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• Figure 6-20 Sample window senings with Modulo 128 

Window---------.. 

Default Size __.!.! III 
MaHimum Size ....!!!_ III 
Modulo O 8 ® 128 

The Modulo that the MacX25 server uses for packet level operations 
affects the setting of both the default and maximum window size. 

5. Use the arrows to the right of Default Size to set the window size 
that the MacX25 server uses when it does not negotiate a window 
size with the network. 

If you click the arrow pointing up, MacX25 Admin increases the setting; if 
you click the arrow pointing down, MacX25 Admin decreases the setting. 

If the MacX25 server uses Modulo 8, you can set the default window size 
to any value from 1 through 7. If the MacX25 server uses Modulo 128, 
you can set the maximum window size to any value from 1through127. 

You cannot set a default window size that is larger than the maximum 
window size. 

The MacX25 server uses the Default Size setting when it does not 
negotiate with the network for this value. 

6. Use the arrows to the right of Maximum Size to set the largest 
window size that the MacX25 server can use. 

If you click the arrow pointing up, MacX25 Admin increases the setting; if 
you click the arrow pointing down, MacX25 Admin decreases the setting. 

If the MacX25 server uses Modulo 8, you can set the maximum window 
size to any value from 1 through 7. If the MacX25 server uses Modulo 128, 
you can set the maximum window size to any value from 1 through 127. 

The Maximum Size parameter specifies the largest window size that the 
MacX25 server can use. 
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Setting the timers The Timers parameter group displays the current settings for the 1'20, 1'21, 
1'22, 1'23, 1'24, 1'25, 1'26, and T28 packet-level timers. You should negotiate 
these values with your network vendor before setting them in the MacX25 
parameter file 

You can find infonnation on the 1'20, 1'21, 1'22, 1'23, and T28 timers in the 
CC/TT Recommendation X.25, also known as the Redhook. The 
International Standards Organii.ation (ISO) defines the 1'24, 1'25, and T26 
timers. 

To view and change any of the settings in the Timers parameter group, 
follow these instructions: 

1. Select Timers from the pop-up menu under the parameter file 
icon, as Figure 6-21 shows. 

• Figure 6-21 Choosing the Timers parameter group 

Rd dressing 
Charging 
Channel Rllocatlon 
Freme Leuel 
Packet & Window Size 

/f1me1s 

MacX25 Admin displays the Timers parameter group, as Figure 6-22 
shows. 
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• Figure 6-22 The Timers parameter group 

!l!O Telenet_DiaLOut 

Use.t BIJ: Cemments 

I 
I 

M Default X.25 Confi9uretion file for bl Telenet Dial-Out Operations 

.._ ________________ __.._ ....... 

Timers 

T20 ~sec. T24 ~sec. 

T21 160 I sec. T25 160 J sec. 

T22 ~sec. T26 ~sec. 

T23 160 J sec. T28 ~sec. 

2. Set the value of the T20 timer, if needed 

The T20 timer specifies how many seconds after the MacX25 server sends 
a restart request that it waits for a restart confirmation or indication 
before sending another restart request. 

3. Set the value of the T21 timer, if needed 

The T21 timer specifies how many seconds after sending a call request 
that the MacX25 server waits for a call connected, clear indication, or 
incoming call before the MacX25 server sends a clear packet. 

4. Set the value of the T22 timer, if needed 

The T22 timer indicates how many seconds after sending a reset request 
that the Mac.X25 server waits for a reset confirmation or reset indication 
before retransmitting the reset request packet. 
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S. Set the value of the n3 timer, if needed. 

The T23 timer detennines the number of seconds after the Mae}{25 server 
sends a clear request that it waits for a clear confirmation or clear 
indication before it retransmits the clear request packet. 

6. Set the value of the T24 timer, if needed. 

The T24 timer sets the number of seconds after sending an 
acknowledgment that the MacX25 server waits before it sends a Receiver 
Ready (RR) packet. 

7. Set the value of the ns timer, if needed. 

The T25 timer specifies the number of seconds after sending a data 
packet that the MacX25 server waits for an acknowledgment before 
resetting the virtual circuit. 

8. Set the value of the n6 timer, if needed. 

The T26 timer indicates how many seconds after the Mae}{25 server sends 
an interrupt packet that it waits for the interrupt confirmation before 
resetting the virtual circuit. 

9. Set the value of the ns timer, if needed. 

The T28 timer indicates the number of seconds after sending a 
registration packet that the Mae}{25 server waits for a confirmation 
before it resends the registration packet. 

Undoing changes to a parameter file 

You can use the Revert command in the Pile menu, as Figure 6-23 illustrates, 
to undo the changes that you have made to a parameter file since the last 
save. 

You cannot use the Revert command to undo changes that you made prior 
to saving the file. 
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• Figure 6-23 Choosing Revert from the File menu 

Open Puameter File... XO 
Close 8SW 
Sm1e :l(:S 
Saue Rs .•. 
Reuert 

Open Master Address Boole ••• 

Show Log 
Change Rdmin Key 

Quit Rdmin 

Saving changes to a parameter file 

To maintain the integrity of the parameter files that the MacX25 product 
provides, you must save your changes to a new parameter file. 

To save your new settings, follow these instructions: 

1. Choose Save As from the File menu, as Figure 6-24 illustrates. 
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• Figure 6-24 Choosing Save As from the File menu 

Open Parameter File... XO 
Close XW 
Sa Pe *S 
Saue Rs ••• 
Reuert 

Open Master Address Boole ••• 
....... ----·------

Show Log 
Change Rdmin Key 

Quit Rdmin XQ 

Notice that the Save command is dimmed in Figure 6-24. 

MacX25 Admin displays the dialog box that Figure 6-25 shows. 

• Figure 6-25 Naming the new parameter file 

Saue H.25 Parameter File 

ll(>l>h~ .... D[ 1: _1 <L[lr[ 

ll 1> I> h.' -. DTE .... 1 <1....ll C [ 
01: 1: l"<~l<m<~1 

1;.1:1s ... A5m1 
·r.~h~m~t Oiol Out 

Saue es: 

Saue 

Cancel 

2. .Type the name that you want for your new parameter file, and 
click Save. 
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The name }rou enter can have up to 31 characters and must be unique to 
the MacX25 Folder. You cannot use a colon(:) character within a filename. 

Closing the parameter file 

When you want to put away the parameter file that you are viewing, you 
can either click on the close box in the upper-left comer of the parameter file 
window or you can choose Oose from the File menu. Figure 6-26 shows the 
File menu with the Close command highlighted. 

• Figure 6-26 Closing a parameter file 

SaPe •s 
Seue Rs ... 
Reuert 

Open Master Address Book ••• 

Show Log 
Change Rdmin Key 

Quit Rdmin XQ 
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C H A P T E R 7 

Building a Master Address Book 

w ml MACX25 ADMIN, YOU CAN BUUD AND MAINTAIN A MASTER ADDRESS 

Book for the MacX25 users. The Master Address Book contains the 

connection infonnation that a MacX25 user needs to connect to a MacX25 

server and to place or receive an X25 call. 

MacX25 Admin uses the Open Book application to create the Master Address 

Book and to display its contents to you. 

This chapter contains instructions for putting information into the Master 

Address Book and for making changes to the information. 

You must put MacX25 Admin into its administration mode to open the 

Master Address Book. Chapter 3 contains instructions for putting MacX25 

Admin into administration mode. 
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Open Book 

Address files 

Understanding MacX25 address files 

This se<.tion tells you about Mae){25 address files, and describes the 
information that an address file contains. You may find this information 
helpful when you are working with the Master Address Book. 

The Open Book program displays information from an addresses file. 

You use Open Book to build a new addresses ftle and to view, add to, and 
edit the contents of an existing addresses file. 

Although Open Book is a stand-alone application that you can open from 
your desktop, Open Book also allows other programs to use it. For example, 
MacX25 Admin provides a command that uses Open Book. The MacP AD 
program, which is included in the Mae){25 User software, uses Open Book to 
display connection choices to a MacX25 user when the user sets up a 
MacP AD connection. 

Open Book creates two address files for Mae){25, the Master Address Book 
and the Addresses file. 

When Mae){25 Admin uses Open Book, Open Book displays information from 
its Master Address Book. F.ach MacX25 gateway in your AppleTalk network 
system has its own Master Address Book. 

Mae){25 users can use the Chooser to connect to a MacX25 server and to copy 
information from the Master Address Book to a local Addresses file that · 
resides in the System Folder of the user's Macintosh. 

If any program other than MacX25 Admin uses Open Book, or if you launch 
the Open Book program from your desktop, Open Book displays 
information from the Addresses file. 
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6 Important Do not remove the Master Address Book from the MacX25 Folder or the 
Addresses ftle from the System Folder of your hard disk. Open Book only 
looks for the Master Address Book in the MacX25 Folder. Open Book only 
looks for the Addresses file in the System folder. !:::. 

What an address me 
contains 

APPLE co:NFIDENTIAL 

The Open Book program provides a command for creating new address files 
and for opening other address files that you create. When you create a new 
address file, you can give it any name you choose 

An address file contains entries. Each entry has an entry name and two 
records. The records contain the information that a program, like MacP AD, 
needs to connect to a MacX25 server and place a call to, or receive a call from, 
a host computer connected to the packet-switched data network that the 
MacX25 server supports. 

The MacX25 records are X.25 Server and X.25 C.Onnection. 

The :X.25 Server record contains the name and zone of a MacX25 server in the 
AppleTalk network. 

The X.25 Connection record contains either the X.25 network address of the 
host, so MacP AD can place a call to that host; or it contains specifications 
that make it possible for the MacX25 server to receive an X.25 call from the 
host. The data in this record must confonn to the CCIIT recommendations 
for technical content and format. 

Opening the Master Address Book 

To open the Master Address Book, follow this instruction: 

Choose Open Master Address Book from MacX25 Admin's File 
menu, as Figure 7 -1 shows. 
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• Figure 7·1 The Open Book dialog box 

Open Parameter File... XO 
£ lt>se >l!(ln 
Sa Pe •s 
S<lll<~ fl~ ... 
R•WNt 

Open Master Hddr-ess Book ..• 

1----·--·-·-----·---· 
Show Log 
Change Rdmin Key 

Quit Rdmin •o 

If you are opening the Master Address Book for the first time, Open 
Book creates the file and displays the empty dialog box that Figure 7-2 
shows. If you have previously opened the Master Address Book and 
added entries to it, the list of entries appears in the upper-left list box of 
the dialog box. 

• Figure 7·2 The Open Book dialog box 

t • Fiie [dlt l 
Mester Address Boole 

n 
~ 

I 
~ 0 

["' 
I 

I I Edit 

( Done ) 
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Because you cannot use the menus at the top of your screen when you are 
using Open Book, Open Book provides its own menu bar for editing entries 
and records in the Master Address Book, and for gaining access to other 
address files, if you have any available to you. 

The box in the upper-left portion of the dialog box i.5 empty because you 
have not yet added any entries to Master Address Book. The information 
box usually contains a brief description of a selected item. Because the 
Master Address Book is empty, the information box is also empty. 

When you place your cursor on a menu, command, or button and hold your 
mouse button down, the information box contains a description of the 
control. 

Adding entries to the Master Address Book 

To add new entries to the Master Address Book, follow these steps: 

1. Choose New Entry from Open Book's Edit menu. 
' Figure 7-3 shows Open Book's Edit menu with the New Entry command 

highlighted. 

• Figure 7-3 Choosing New Entry from Open Book's Edit menu 

I[ • Fiie mm 
(UI :•:H 

Mester (OPlj :•:C 
Pes1e :•:11 IQ: 
UP er 

Ill 

y IQ 
r.lnfo 
l)lt 1111 Edit .... to cut, cop~. posit, or cl•r ontr1eo 

I I ond r-rdl, ond to c..- - onlrieo. Edl1 

I Done l 
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Ftgure 7-4 shows how the Open Book dialog box appears after you 
choose New Entry from the Edit menu. 

• Figure 7-4 Naming the new entry 

( . Fii• Edit ) 
Mester llddress Boole 

l!=I IQ 

lo ~ 

Neme the new entry: I OK I 
j rlnenclel News I I Cancel ) 

2. Type the name that you wish to give the new entry. 

The name should identify the service to which the MacX25 user connects 
when the user selehs this entry. 

3. CJick OK. 

The new entry now appears in the upper-left list box. The upper-right list 
box shows the X25 Connection and X25 Server records. A pencil icon 
precedes each record. The pencil icon indicates that you can view and 
modify the information in the record. 

Figure 7-5 with the Open Book dialog box with one entry. The entry's 
records are empty. 
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the X.25 Connection 
record 
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• Figure 7-5 A new entry with no information in its records 

'ii. Fiie £dll 

Mester Rddress Boat 

f IOdfi( 1c1I Nput\ H.25 Connection 
M.25 Seruer 

I Edi1 I 
Done 

To put information into the X.25 Connection record, follow these steps: 

L Select the X.25 connection record, as Figure 7-6 shows. 

• Figure 7-6 Selecting the X.25 Connection record 

'ii. Fiie Edit 

Mester Rddress Boot 

Flnanc1111 News : H Z5 (OOOPCtlon ,..;; 

~ H.25 Seruer 

...... 

~~."'zs""eo_n_..:ti""·o""'n·,.,..to-odi"""·t.,,..x.2=s,_.11111-r---.,.t•....,i.st=-11 __, 
for .. t. I [dit I 

Dene 
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2. Click Edit 

Open Book displays the dialog oox that Figure 7-7 shows. 

• Figure 7-7 The empty X.25 Connedion record 

H.25 Connection Record 

Reuert 

Cancel K Saue 

3. Type the full X.25 network address of the host, as Figure 7-8 
demonstrates. 

Do not put a "c" in front of the network address. MacP AD does this 
automatically when it uses the infonnation in this record to make an X.25 
call. 
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• Figure 7-8 Entering information into an X.25 Connection record 

H.25 Connection Record 

r-31109090001 ~ 

Reuert 

Cancel n Seue 

4. Click Save. 

The X.25 Connection record is now preceded by both a pencil and a check 
mark, as Figure 7-9 shows. The check mark indicates that the X.25 
Connection record contains information. 

• Figure 7-9 An X.25 Connection record that contains information 

'Iii file Edit 

Mester Rddress Book 

Financial News ; ./H.25 C onnec tmn r!1 
.J H.25 Seruer 

J!~.=2s'""eo_n_noct1..,.,.o-.n·"""to-ldt"""t-x.=2s-11111-,,_--;n....,ASC"""'"11 --. 
formot. I Edit I 

Done 
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Putting information into 
the X.25 Server record 

To put information into the X.25 Server record, follow these steps: 

1. Click on the X.25 Server record as Figure 7-10 shows. 

• Figure 7-10 Selecting the X.25 Server record 

( • Fiie Edit ) 
Mater Rddre11 look 

Finenclel News I.._~H.25 Connection ~ 

~ 
... 

~ 

r~~.25 Connection· to "'1t X.25 eddr .... 1n ASCII 

I I forlllll. Edit 

( Done l 

2 Click Edit 

The Address Book displays a dialog box like the one Figure 7-11 shows. 
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• Figure 7-11 Puning infonnation into an X.25 Server record 

""zo_n""'""es_: -----rr. I 91H.mlzsmsmeru!men1:••••12l 
Corporate Zone 11 Ill " , , 
Engineering Zone ! R It O Net 
finance Zone ~ I Tren111ec 

lml!lmartl .. ~,..__~~~~~~ 
·h I 
. " i Name: I torporateNet 

, I • 

....._ ____ .........,'" I Zone: I Mertel Zone 

,,,_Info--------. .....--...., 
Select e zone. then e server. Vou [ lleuert ] 
can just type 1n the zone end 
server names H you can't see the [ cancel ) ( 
ones JI.OU went. • 

Saue I 

3. Select the AppleTalk zone to which your MacX25 gateway is 
connected from upper-left list box. 

You can scroll through the list if you don't immediately see the zone you 
want. If the list does not contain the zone, you can type this 
information into the Zone text edit box. 

4. Select the MacX25 Server that supports connections to the host 
named in this entry from the upper.right list box. 

You can scroll through this list if you don't immediately see the MacX25 
server you want. Open Book only displays the server name if the server is 
started or busy; otherwise Open Book does not "see" the server. 

If you do not find the MacX25 server's name in the upper-right list box, 
you can type the name into the Server text edit box. 

5. Click Save. 

If you do not want to save the information, you can click Revert or 
Cancel to undo the changes that you just made. If you click Revert, Open 
Book continues to display the record contents. If you click Cancel, Open 
Book closes the X25 Server dialog box. 

The X25 Server record is now preceded by both a pencil and a check mark, 
as Figure 7-12 shows. The check marks indicate that both records 
contain information. 
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Copying an entry 

• Figure 7-12 An entry with information in both of ils records 

( • Fiie Edit 

MHter Rddrn1 look 

f lfldlU ldl Nf'lll\ r: .,..11.25 Connection 
.I .,..H.25 Server 

I Edit I 
Done 

At this point, you can continue to work in your Master Address Book or you 
can quit the Open Book program. You do not lose any of the information in 
the Master Address Book when you quit Open Book. 

Working with entries 

You can use the Open Book Edit menu to cut, copy, paste, and clear entries. 

You normally copy an entry to paste it into another address file. To copy an 
entry, follow these steps: 

1. Select the entry that you want to copy. 

2. Choose Copy from the Open Book Edit menu. 

The Copy command includes the name of the selected entry. Figure 7-13 
shows Open Book's Edit menu with the Copy command highlighted. 
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• Figure 7·13 Choosing Copy from Open Book's Edit menu 

• rue 
tut flnenclel News XH 

Mester ( Ofl\f fmdll(ldl P"riiell'\ •C 

lllll!mim:~P~n~st~e =====:~·:1~1 -'H.25 connection r" ,.tH.25 Server 
Clear flnenclel News 

XE 

Info __________ ~ 
lbl the Edtt menu tCI cut, COPfil, pate, or cl•r entries 
end record9, end to ereete,...... entria. ( Ed~I J 

Done 

Open Book puts a copy of the entry with all of its record information 
onto your Clipboard, where it remains until your next cut or copy 
operation. The original entry remains intact in its current position in the 
Master Address Book. 

When a copy of an entry resides on your Clipboard, you can use the Paste 
command under Open Book's Edit menu. You can find instructions for 
pasting an entry, and for opening another address file, in later sections of this 
chapter. 

You normally cut entries to paste the entry in another address file. To cut an 
entry, follow these steps: 

1. SeJect the entry that you wish to cut. 

2. Choose Cut from the Open Book's Edit menu. 

'Jbe Cut command includes the name of the selected entry. Figure 7-14 
shows Open Book's Edit menu with the Cut command highlighted. 

CH APTER 7: Building a Master Address Book 5/31/89 105 



Pasting an entry 

• Figure 7-14 Choosing Cut from Open Book's Edit menu 

4J file :-w.-
Master Copy rtnenclel News ac 

P11S1e :•:11 ,-.tK.25 Connection :!.! 
.tK.25 Seruer 

Clear flnenclel News 

New En!!:ll ... •£ 

" ... 1 K5i 

,...Info 
Uoe Ille Edit,,.. •• tm cut, COPV. pottt, or cl•r entria 

I I end recordS, end to cr11t1 new entri•. Edi! 

( Done ) 

Open Book removes the entry name from the upper-left list box, and 
puts the entry with all of its information onto your Clipboard, where it 
remains until your next cut or copy operation. 

When a cut entry resides on your Clipboard, you can use the Paste command 
under Open Book's Edit menu. You can find instructions for pasting an 
entry, and for opening another address file, in later sections of this chapter. 

When an entry resides on your Clipboard, you can paste the entry into 
another address file. You can find instructions for opening another address 
file later in this chapter. 

To paste an entry, follow these steps: 

1. Choose Paste from the Open Book Edit menu. 

The Paste command includes the name of the entry that you last cut or · 
copied. Figure 7-15 shows Open Book's Edit menu with the Paste 
command highlighted. 
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• Figure 7-15 Choosing Paste from Open Book's Ed.it menu 

• me Dim 
Cut Flnenclel News XH 

Mester Col!ll. Flnenctal News xc 
.,1H.25 Con nee tton :Q: 
.,1H.25 seruer 

Clear Flnenctal News 
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,..Info 
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I I Ind r.cordt, Ind to Creltl IW'it tntr1•. Ecl1I 

( Done ) 

Open Book displays a dialog box like the one Figure 7-16 shows. Open 
Book considers the entry on your Clipboard to be a new entry, and so it 
displays the New Entry text box in the lower portion of the dialog box. 

• Figure 7-16 Pasting an entry 

j Fiie Edit 

Mester llddress look 

f IOdfU ldl Nt>ttt\ 

Name the new entry: 

.,1H.25 Connection 
..J .,1H.25 seruer 

I OK I 
Cancel 

2. Type the name that you want to give the entry, and click OK. 
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Oearing an entry 

If you want the entry to have the displayed name, you can click OK 
without typing anything. 

The upper-left list box now contains the name you gave the entry in 
step 2. Open Book automatically puts the entry in alphabetical order in 
the list. 

You can use the Clear command from the Edit menu to delete an entry from 
the Master Address Book. 

To delete an entry, follow these steps: 

1. Select the entry that you want to delete. 

2. Choose Oear from Open Book's Edit menu. 

The Clear command includes the name of the selected entry. Figure 7-17 
shows Open Book's Edit menu with the Clear command highlighted. 

• Figure 7-17 Choosing Clear from Open Book's Edit menu 

• Fiie llliD 
tut H.25 Connection •H 

Master Copy H.25 Connection •t 
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! Done l 

Open Book delets the selected entry from the Master Address Book and 
removes its name from the upper-left list box. 

1(8 MacX25 Administrator's Guide - Beta Draft 5/31/89 APPLE CONFIDENTIAL 

,,,,,·-



( 

Copying a record 

( 

APPLE CONFIDENTIAL 

Working with records 

You can also use the Open Book Edit menu to cut, copy, paste, and clear 
records. 

You normally copy a record to paste it into another entry. To copy a record, 
follow these steps: 

1. Select the entry whose record you wish to copy. 

2. Select the record that you want to copy, as Figure 7-18 shows. 

• Figure 7-18 Selecting a record to copy 

( . File Edit ) 
Master Address Book 

Financial News I ' 

I ... j..l -'H.25 Seruer 

kE <._ 
~ 

•J!~.25 Connection· to och1 X.25 eddr ..... in ASCII 

I I fornt Edit 

( Done ) 

3. Choose Copy from the Open Book Edit menu. 

The Copy command includes the name of the record, as Figure 7-19 
shows. 
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Cutting a record 

• Figure 7-19 Choosing the Copy command to copy a record 

• Fiie ll!llll 
Cut 11.25 Connection •11 

Mester 

t~or!! Paste •u 
Flnencle ... 11.25 Server 

Clear R.25 Connection 

New En!!Y_ ••• •E 

~ ·.. l .... 
lo 

r:-.lnfo 
I.lie tlW Edit .... to cut, cop~. poote, or cl•rtntr1• I I •nd , .. ,. , end to crwtt NV 1ntrta. Edit 

( Done l 

Open Book puts a copy of the infonnation in the record onto your 
Clipboard, where it remains until your next cut or copy operation. The 
information in the copied record remains intact. 

When a copy of a record resides on your Oipboard, you can use the Paste 
command under Open Book's Edit menu. 

You normally cut a record to move the information in the record from one 
entry to another entry. To cut a record, follow these steps: 

1. Select the entry whose record you wish to cut 

2. Select the record that you wish to cut 

3. Choose Cut from the Open Book's Edit menu. 

The Cut command shows the name of the selected record. 

The program deletes the infonnation in the record and puts the 
information onto your Clipboard, where it remains until your next cut or 
copy operation. 

When record information resides on your Oipboard, you can use the Paste 
command under Open Book's Edit menu. 
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Pasting a record 

APPLE CONFIDENTIAL 

When record information resides on your Clipboard, you can paste the 
infonnation into the same record of another entry. To paste infonnation 
from a cut or copied record, follow these steps: 

1. Select the entry into which you want to paste the record. 

2. Choose Paste from the Open Book Edit menu. 

The Paste command includes the name of the record that you last cut or 
copied. Figure 7-20 shows Open Book's Edit menu with the Paste 
command highlighted. 

<- If the Paste command shows an entry name rather than a record, you 
may not have cut or copied the record. You must cut or copy the 
record of one entry before you can paste it into another entry. 

• Figure 7-20 Choosing Paste after cutting or copying a record 

• Fiie lliiD J 
Cut rtnencl•I News •N 

Mester Cal!!!.. Flnenctel News •c 
COflJDret N.25 Connection p..! 

N.25 Server 
Clear Flnenclel News 

New En!!!!. ... •E 

Q '\l ~ 
,-Info 
I.be the Edit menu to cut, COPIJ, pate, or cl•r entries 

I I •fld r.::oros, 1nd to cr•te new entn•. Edit 

( Dane ) 

Open Book puts the record information in the Clipboard into the 
corresponding record of the selected entry. Any information previously 
in the record is destroyed. 
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dearing a record 

Modifying the X.25 
Connection record 

You can use the Clear command from the Edit menu to delete a the 
information in the record. To clear the contents of a record, follow these 
steps: 

1. Select the entry whose record you wish to clear. 

2. Select the record whose information you wish to delete. 

3. Choose Clear from Open Book's Ed.it menu. 

The Clear command includes the name of the record. 

Open Book clears any information in the record, leaving the record empty. 
You can tell that the record is empty because no check mark precedes the 
record in upper-right list box. 

Making changes to the information in records 

You can modify the contents of a record in the same way that you initially 
put information into a record. This section describes how to modify the 
contents of the X25 Connection and X25 Server records. 

To modify the X25 Connection record, follow these steps: 

1. Select the entry whose record you wish to modify. 

2. Double-click X.25 Connection. 

Open Book displays the X.25 Connection information dialog box. 
Figure 7-8, which appears earlier in this chapter, shows this dialog box. 

3. Type the current X.25 network address of the host 
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Modifying the X.25 Server 
record 

APPLE CONFIDENTIAL 

Do not put a •c• in front of the network address. MacP AD does this 
automatically when it uses the infonnation in this record to make an X.25 
call. 

4. Click Save. 

If you do not want to save the information, you can click Revert or 
Cancel to undo the changes that you just made. If you click Revert, Open 
Book continues to display the record contents. If you click Cancel, Open 
Book closes the X.25 Conneaion dialog box. 

To modify the contents of the X.25 Server record, follow these steps: 

1. Select the entry whose record you wish to modify. 

2. Double-click X.25 Server. 

Open Book displays the X.25 Server infonnation dialog box. Figure 7-11, 
which appears earlier in this chapter, shows this dialog box. 

3. Select the AppleTalk zone to which the MacX25 gateway is 
connected from the upper-left list box. 

You can scroll through this list if you don't immediately see the zone you 
want. If the list does not contain the zone, you can type this 
infonnation into the Zone text edit box. 

4. Select the MacX25 Server that supports connections to the host 
named in this entry from the upper-right list box. 

You can scroll through this list if you don't immediately see the MacX25 
server you want. If the list does not contain the MacX25 server's name, 
you can type this infonnation into the Server text edit box. 

5. Click Save. 

If you do not want to save the infonnation, you can click Revert or 
Cancel to undo the changes that you just made. If you click Revert, Open 
Book continues to display the X.25 Server information. If you click 
Cancel, Open Book closes the X25 Server information dialog box. 
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Opening another address file 

If you launch Open Book directly from your desktop, you can follow these 
instructions to display inf onnation from the Master Address Book rather 
than from the local Addresses file. 

1. Choose Open from the File menu, as Figure 7-21 shows. 

• Figure 7·21 Choosing Open from Open Book's File menu 

I Edl1 I 
Done 

The program displays the dialog box that Figure 7-22 illustrates. The 
shadow box above the list box contains the name of the folder that you 
are currently viewing, which is your System Folder in this case. 

• Figure 7-22 Selecting another address ftle 

lo MacH25 Folded 

CJ l'!Jl_S 1Q1 = l'et'1 II 

Open 
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2. Use the pop-up menu above the list box to select your hard disk. 

Open Book displays the list of files and folders at the top level of your 
hard disk. 

3. Locate the MacX25 Folder. 

The MacX25 Folder can reside anywhere on the hard disk of the 
Macintosh. 

4. Open the MacX25 Folder by double-clicking its name. 

5. Open the Master Address Book by double-clicking its name. 

Open Book displays the entries from the Master Address Book. 

Creating another address file 

You can create another address file at any time by following these 
instructions: 

1. Choose New from Open Book's File menu, as Figure 7-23 shows. 

• Figure 7-23 Choosing New from Open Book's File menu 

[(•mEdil 
"'! Open ... XO Book - ~ IQ: ~ Quit XO i--""'" 

ouersees office 

tQj to: 

["" 
I 

I I Edit 

( Done ) 
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The program displays a text box in which you can enter a ftlename. The 
text box appears in the lower portion of the Open Book dialog box, as 
Figure 7-24 shows. 

• Figure 7-24 Naming a new address file 

la M11cH25 Folder I 
Cl flnother g11tew11y io! c:>Pet's II 
Cl Rpple...DCLto_ou 
Ci Rpple...DTLlo_DCE Ejec1 
Ci DCr lPIPnPt 01;1oe 
Ci DTE Telenet 
Ci GEIL'l'iKK 

Create new book: S11ue 

• , • · · ( Cancel ) 

2. Type the name that you want to give to the new address file. 

3. Click OK. 

Open Book creates the new file and displays it to you. The filename 
appears above the list box in the upper-left portion of the dialog box. The 
list box is empty because you have not added any entries to it. 

Quitting Open Book 

When you finish working in the Master Address Book, follow this 
instruction to quit Open Book and return to MacX25 Admin: 

Click Done. 

You do not lose any of the information in the Master Address Book when 
you quit Open Book. 
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Viewing MacX25 Gateway Activity 

A fTER YOU HA VE USED MACX25 ADMIN TO CREA TE A MACX25 SERVER, TO SET 

user access privileges, and to put entries into the Master Address Book, you 

can use MacX25 Admin's information mode to view activity on the MacX25 

gateway. 

This chapter tells you how to use MacX25 Admin's information mode to 

view the activity on your MacX25 gateway. The chapter also includes 

instructions for launching MacX25 Admin after the MacX25 Servers and 

MacX25 Users ftles are created. 
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Launching MacX25 Admin 

To launch MacX25 Admin after the MacX25 Servers and MacX25 Users files 
are created, follow these instructions: 

1. Locate the MacX2S Folder on your hard disk. 

The MacX25 Folder can reside anywhere on your hard disk, so you may 
need to look for it You may find it convenient to put this folder at the 
top level of your hard disk or directly on your desktop. 

2 Open the MacX25 Folder by double-clicking its icon. 

The system displays the contents of the MacX25 Folder. 

3. Double click the MacX25 Admin icon to launch the application. 

-> If you have MacX25 servers set for automatic startup, you can 
override the automatic startup operations by holding down the 
command key as you launch the program. 

The MacX25 Admin and MacX25 Log windows now appear on your 
screen. 

The MacX25 Admin and MacX25 Log windows contain information about 
your MacX25 gateway. The next two sections of this chapter describe how 
to use these two informational windows. 

How to use the MacX25 Admin window 

The MacX25 Admin window contains information about the current use of 
the MacX25 gateway. 
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Viewing the MacX25 
Admin window 

• Figure 8-1 

~D 

The MacX25 Admin window has a picture of the Macintosh NuBus slots, a 
Servers list box, and a Users Ii.st box. Figure 8-1 shows how this window 
may appear. 

A Sample MacX25 Admin window 

-------- MacH25 Rdmin --==---::::..=-
===-~~----

Cords: 

1 2 3 4 5 6 -
/1acX25 

User 
<Guest> 

Server 
Trans pee 

Server 
Corporate Net 
Trans pee 

Slot VC's 
4 0 :Q 
3 1 

Fri, May 1 2, 1989 3:11 :31 PM 

Determining slot conditions 

By the way a slot appears in the MacX25 Admin window, you can tell 
whether or not the slot contains an Apple Serial card, and you can tell the 
current state of the MacX25 software on a slot that does contain an Apple 
Serial Card. Figure 8-2 shows how each possible slot condition is represented 
in the MacX25 Admin window. These are the same slot representations that 
appear in a Server Information window, as Chapter4 describes. 
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• Figure 8-2 

Empty 

Possible slot conditions 

~ kliw wOh p•nding ""P 

~ IU•ywOh p•nding ""P 

In Figure 8-1, only slots 3 and 4 have Apple Serial cards; slot 3 is running 
Mae)(25, and is supporting one user connection; and slot 4 is running Mae)(25, 
but has no virtual circuits. 

Viewing user activity 

The user list box in the Mae)(25 Adrnin window shows the registered MacX25 
users that currently have virtual circuits, and indicates the MacX25 server 
that is supporting each user's connection. In Figure 8-1, one Guest user has a 
connection through the Transpac server. 
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Displaying the MacX25 
Admin window 

Viewing server activity 

The server list box in the MaOOS Admin window lists all of the servers that 
are saved, identifies the slot to which the server is assigned, and indicates the 
number of current connections through the server. Figure 8-1 shows a 
MacX25 server that is out ri service. A server that is out of service is not 
assigned to any slot on the MaOOS gateway. 

If you are running MaOOS Admin under MultiFinder, you may want the 
MaOOS Admin window to disappear from your screen while you work with 
another program. 

You can at any time put the MaOOS Adrnin window away while MacX25 
Adrnin is still running by clicking the close box in the upper-left comer of the 
window. 

When you want to display the MacX25 Admin window again, choose Show 
MacX25 Admin Window from the Special menu, as Figure 8-3 shows. 

• FiglU'e 8-3 
menu 

Choosing Show MacX25 Admin Window from the Special 

How to use the MacX25 Admin Log window 

The Ma005 Log window li.5ts any events that occur while the program is 
running. 
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· Viewing the log 

Controlling the MacX25 
Admin Log window display 

The MacX25 Admin displays in the MacX25 Admin Log all of the events that 
occur while the program is running. Figure 8-4 shows an example of how a 
MacX25 Admin Log window might appear after you add users to the 
gateway and start the servers. 

• Figure 8-4 Sample MacX25 Ad.min Log window 

~O MocH25 Rdmin Log EJii 
05/12/8902:15:56 PM - Mac:X25 Acllllin ProgrCllll Started. 
~/12/89 02:30:22 PM - User Joy:• Clerk Created 
05/12/89 02:31: 11 PM - User Andy Richard Created 
05/12/89 02:32:22 PM - User Susan Wan Created 
05/12/89 02:33:07 PM - User Barbara Spencer Created 
05/12/89 02:34:07 PM - User Dave Robertson Created 
05/12/89 02:34:34 PM - User Pat Johnson Created 
05/12/89 02:34:37 PM - User Pat Johnson Modified 
05/12/89 03:06:26 PM - CorporateNet Started. 
05/12/89 03:07:52 PM - Transpac Started. 
05/12/8903:11:20 PM - User <Guest> Logged In Transpac 

MacX25 Admin temporarily stores the events that it displays in the MacX25 
Admin Log window in an area of computer memory that is large, but that 
does not grow. When MacX25 Admin fills the log storage area, the program 
begins writing new events over the oldest stored events. 

When you quit the program, all events stored in temporary memory are lost. 

You can save the contents of the MacX25 Admin Log window to a file, but 
only when MacX25 Admin is in its administration mode. You can find 
instructions for saving the contents of the MacX25 Admin Log window in 
Chapter 3 of this guide. 

If you are running MacX2S Admin under MultiFinder, you may want the 
MacX25 Admin Log window to disappear from your screen while you work 
with another program. 
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You can at any time put the MacX25 Admin Log window away while MacX25 
Admin is still running by clicking the clo.se box in the upper-left corner of the 
window. 

When you want to display the MacX25 Admin Log window again, choose 
Show Log from the File menu, as Figure 8-5 shows. 

• Figure 8-5 , .Choosing Show Log from the File menu 

MacX25 Stop windows 

When you set a pending stop for a MacX25 server, MacX25 Admin displays a 
MacX25 Stop window until the stop occurs or you cancel the pending stop. 
Figure 8-6 shows an example of a MacX25 Stop window. 

• Figure 8-6 A sample MacX25 Stop window 

The text box shows the number of minutes that remain before MacX25 
Admin will stop the server. If any users are connected to the server, MacX25 
Admin periodically notifies them of the pending stop. 

A separate MacX25 Stop window appears for each server with a pending 
stop. You cannot clo.se a MacX25 Stop window without cancelling the stop; 
and you can cancel a stop only when MacX25 Admin is in administration 
mode. 
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Putting MacX25 Adm.in into administration 
mode 

To put MacX25 Admin into its administration mode, follow these steps: 

1. Choose Administration from the Special menu. 

Figure 8-7 illustrates this choice. 

• Figure 8-7 Choosing Administration from the Special menu 

~cX25 Admin displays the dialog box that Figure 8-8 shows. 

• Figure 8-8 Entering your Admin key 

MacH25 Rdmin 

Enter Rdmin Key: 

tilf!991!10!!!!11k ~g [ C ttnc el ] 

2. Type your Admin key, and click OK. 

If you entered an incorrect key, MacX25 Admin displays an error message. 
Click OK. Then type the correct Admin key, and click OK. 
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If the key you typed is correct, MacX25 Admin enters its administration 
mode. Figure 8-9 shows how your screen may appear when you enter 
administration mode. 

When you put MacX25 Admin into its administration mode, your screen 
changes in the following ways: 

• the MacX25 Admin window disappears from your display 

• the commands under the File menu change 

• the Special menu disappears 

• a Users menu and a Server menu appear in your menu bar 

• User List and Server List windows appear on your screen 

The Server List window lists all the the MacX25 servers that you have saved, 
indicates the slot to which the server is assigned, and specifies the current 
state of the MacX25 software on the card. The User List window lists all of 
the registered MacX25 users. The MacX25 Admin Log shows that MacX25 
Admin has entered administration mode. 

You can find instructions for performing specific tasks in MacX25 Admin's 
administrative mode in Chapters 3, 4, 5, 6, and 7. 
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• Figure 8·9 

Nam• 

"'l Corporat•N.t 

""R & D N•t 

"'l Tr anspac 

MacX25 Admin's administration mode 

MacH25 Seruer List 

4 

Not Assi9MC1 

3 

MacH25 User List 

[] <GUKt> 

[] Andy Richard 

[] Barbar a Sp•nc.,. 

[) Dav• Robertson 

Q Joye:• Clark 

Q Pat Johnson ID MacH25 Rdmin Lo E!l~ 
"""o""'s""'"1'""'12,...1a""g,......,,..02,,..:-15""':""'56,..,......,P,...M---Mac:.....,..x""'2s,,......,..Ad_111_i_n"""P-,.-ogr-a111......,.S-ta-,.-te-d-.-----.-.-t 

Q Susan Wan 

Quitting administration mode 

To protect your gateway, you should always keep MacX25 Admin in its 
information mode when you are not performing administrative tasks. 

To put MacX25 Admin into its information mode, choose Quit Admin from 
the File menu, as Figure 8-10 illustrates. 
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• Figure 8-10 Quitting administration mode 

Open Parameter File... XO 
[ It> s (~ :)[: UJ 
Saue XS 
S<ll'<~ fl~ ... 
lb~UNt 

Open Master Address Book ... 

Show Log 
Change Rdmin Key 

Quit Rdmin 3€Q 

Quitting MacX25 Admin 

Because the MacX25 software runs only when MacX25 Admin is running, you 
should quit MacX25 Admin only when you must do so to perfonn a certain 
maintenance task, such as adding another serial card to the Macintosh, or 
upgrading the system. 

MacX25 Admin provides the Quit command under the File menu, as Figure 8-
11 illustrates. 

• Figure 8-11 Quitting MacX25 Ad.min 
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Functionality that MacX25 Supports 

THIS APPENDIX CONTAINS A TABLE TilAT LlS!S THE FUNCTIONAUTY TilAT THE 

MacX25 product supports. The MacX25 Server software provides an X.25 

communications program that provides some X.25 functions that the 

MacX25 Admin program does not currently support. The MacX25 User 
' software provides the PAD functionality. In addition to these, Apple offers 

a MacX25 Developer's Kit for third-party developers who wish to build 

applications that use MacX25. 

The General column of the table describes a function from the CQTI or the 

International Standards Organization recommendations. The X.25 column 

indicates whether the MacX25 software that runs on the Apple Serial NuBus 

Card supports the function. The Admin column indicates whether MacX25 

Admin supports the function. The PAD column specifies if MacP AD 

supports the function. The Programmable column indicates whether the 

MacX25 Developer's Kit supports the function. 
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• Table A·l MacX25 supported functionality 

General X.25 Admin PAD Programmable 

CCITT 1976 Compatible Mode Yes No No No 
CCITT 1980 Compatible Mode Yes Yes No Yes 
CCITT 1984 Compatible Mode Yes Yes Yes Yes 
CCITT 1988 Compatible Mode No No No Yes 

Operation as a DTE Yes NIA NIA NIA 
Operation as a DCE Yes NIA NIA NIA 

X32 Switched Circuit Operation 
At time of ICP card load 

DTE Call Placement Yes No NIA NIA 
DTE Call Answering No No NIA NIA 
Llnk Level XID Exchange Yes No NIA NIA 

Dynamically 
DTE Call Placement No No No No 
DTE Call Answering No No No No 
Llnk Level XID Exchange No No NIA NIA 

One X25 Llnk per Livonia Card Yes Yes NIA NIA 
Operation at 64 Kbps Yes, NIA NIA NIA 

Two X.25 links per Llvonia Card No No NIA NIA 
Operation at 2 x 9.6 Kbps No NIA NIA NIA 

X25 MultiLink Operation No No NIA NIA 

Multiple X.25 Cards per Mac-II Yes Yes NIA NIA 
Multiple Mac-II per A.T. Network Yes Yes NIA NIA 

Subscription Registration 

Annex A 
Permanent Virtual Circuits Yes No 
Switched Virtual Circuits Yes Yes 

One Way Incoming UC I HIC Yes Yes 
Two Way LTC I !ITC Yes Yes 
One Way Outgoing LOCI HOC Yes Yes 

On-Line Facility Registration Yes No 
On-Line Registration Prevention Yes No 
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• Table A-1 MacX25 supported functionality (continued) 

General X.25 Admin PAD Programmable 

Extended Sequence Numbers Yes Yes 
D Bit Modification Yes No 
Packet Retransmission (DTE REJ) No No 

Default Packet Size Assignment 32-4096 32-4096 128 32- 4096 
Default Window Size Assignment 1-128 1-128 
Default Throughput Class Assignment Yes No 
Flow Control Parameter Negotiation Yes No 
Throughput Class Negotiation Yes No 

Closed User Groups 
CUG Yes Yes 
Multiple CUG Support Yes Yes 
CUG with Outgoing Access Yes Yes 
CUG with Incoming Access Yes Yes 
CUG with Incoming Barred Yes Yes 
CUG with Outgoing Barred Yes Yes 

Bilateral Closed User Groups 
BCUG Yes Yes 

C' Multiple BCUG Support Yes Yes 
BCUG with Outgoing Access Yes No 

Fast Select Acceptance Yes No 
Reverse Charging Acceptance Yes No 
Local Charging Prevention Yes Yes 
Network User Identification No No 
Charging Information NIA NIA 
RPOA Seleaion NIA NIA 
Hunt Group NIA NIA 
Call Redirection NIA NIA 

On-Line Registration 

Startup 
D Bit Modification No No No No 
Packet Retransmission No No No No 
Extended Sequence Numbers No No No No 
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• Table A-1 MacX25 supported functionality (continued) 

General X.2S PAD Programmable 

Anytime 
Charging Information Yes No Yes 
Throughput Class Negotiation Yes No Yes 
flow Control Parameter Negotiation Yes No Yes 
Reverse Charging Acceptance Yes No Yes 
Fast Select Acceptance Yes No Yes 
Outgoing Calls Barred Yes No Yes 
Incoming Calls Barred Yes No Yes 

Call Initiation Yes Yes Yes 

Packet Size Negotiation Yes No Yes 
Window Size Negotiation Yes No Yes 
Throughput Class Negotiation Yes No Yes 
CUG Group Specification Yes Yes Yes 
BCUG Group Specification Yes Yes Yes 
Fast Select Yes No Yes 
Reverse Charging Yes Yes Yes 
Network User Identification Yes No Yes 
Request Charging Information Yes No Yes 
RPOA Sele<lion Yes Yes Yes 
Called Address Modified Notification Yes No Yes 
Transit Delay Selection Yes No Yes 
User Data Field Yes Yes Yes 

AnnexG 

Calling Address Extension Yes No Yes 
Called Address Extension Yes No Yes 

Quality of Service Negotiation 
Min Throughput Class Yes No Yes 
End to End Transit Delay Yes No Yes 

Expedited Data Negotiation Yes No Yes 
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• Table A-1 MacX25 supported functionality (conttnued) 

General X.25 PAD Programmable 

Call Reception Yes No Yes 

Packet Size Negotiation Yes NIA Yes 
Window Size Negotiation Yes NIA Yes 
Throughput Class Negotiation Yes NIA Yes 
CUG Group Specification Yes NIA Yes 
BCUG Group Specification Yes NIA Yes 
Fast Select Acceptance Yes NIA Yes 
Reverse Charging Acceptance Yes NIA Yes 
Network User Identification Yes NIA Yes 
Charging Information Yes NIA Yes 
call Redirection Notification Yes NIA Yes 
Transit Delay Selection Yes NIA Yes 
User Data Field Yes NIA Yes 

AppendixG 

Calling Addres.s Extension Yes NIA Yes 

(' Called Address Extension Yes NIA Yes 

Quality of Service Negotiation 
Min Throughput Class Yes NIA Yes 
End to End Transit Delay Yes NIA Yes 

Expedited Data Negotiation Yes NIA Yes 

Yes: Supported 
No: Not Supported 
+++"Subscription Parameter, no effect on either software support or testing" 
NIA: "Not Applicable, No Effect" 
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A p p E N D x B 

Parameter Settings in the MacX25 
Parameter Files 

T ms APPENDIX CONTAINS TABLES THAT usr 1llE PARAMrnR SErnNGs FOR 

each parameter file that the MacJ{25 product provides. You can use this 

information to determine the parameter file that best fits the X.25 

requirements for your MacX25 server. 

You may wish to bring this information with you when you negotiate your 

X.25 service requirements with the representatives from the packet­

switched data network to which you subscribe. 
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• Table B-1 Default DTE 

Parameter Display Value User C.Onfigurable 

Internal L2 Parameters 
Auto Start No 
Max Rec Buffers 16 
Min Rec Buffers 4 
Min Free Buffers 10 
Min Free Buffers Timeout (msec) 500 msec 
FIFO FlowControl Llmit 4 
Register with S.A. No 

AutoCall 
ACU Mode NoACU 
ACU Timer (sec) Osec 

Frame Level 
Clock Mode External 
Transmission Speed External 
I.AP Mode LAP-B 
Connection Type DTE Yes (1) 

Connection Mode Send SABM, Wait UA Yes 

Frame Level Modulo 8 Yes 
Window Size 7 Yes 
Tl Timer (msec) 3000 msec Yes 
T3 Timer (sec) 20sec 
T4 Timer (sec) IO sec Yes 

N2 Counter (max error re-xmit) 20 Yes 
DCD Poll Timer (msec) 500 msec 
DCD Retry Counter 2 
XID Pl Timer (msec) 3000 msec 
XID C2 Counter 20 

Network Specific Options: 
Force all FRMR in FRMR state No 
Force RR FRMR in FRMR state No 
Ignore Commands with P IF Bit No 
Disc Answer No 
Disc Action No 
Info Count Escape Yes 
N2 Action Yes 
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• Table B-1 Default DTE (continued) 

Parameter Display Value User C.Onfigwable 

Internal L3 Parameters 
Highest LCN ( + 1) 
PVC Table Offset 
Max Packet Size 2 
Interface FlowWindow 2 

Packet Level 
Network Dr--i1c 0 Ye.s 
Network Specification 1984 
Connection Type DTE 
Packet Level Modulo 8 Ye.s 

Default RX Window Size 2 Ye.s 4 
Default TX Window Size 2 4 
Max Negotiated RX Window Size ..., Ye.s 5 I 

Max r\egotiated TX Window Size 7 5 
Default RX Packet Size 128 Ye.s 3 

Default TX Packet Size 128 3 
Max Negotiated RX Packet Size 4096 Ye.s 2 

c Max Negotiated TX Packet Size 4096 2 
Lowest PVC Number 1 
Number of PVCs 0 

Lowest Incoming SVC Nbr 1 Ye.s 
Number of Incoming SVCs 0 Ye.s 
Lowest Two-Way SVC ~br 1 Ye.s 
Number of Two-Way SVCs 16 Ye.s 
Lowest Outgoing SVC \'br 17 Ye.s 

Number of Outgoing SVCs 0 Ye.s 
T20 Timer (sec) (Restart Request) 180 sec Ye.s 
T21 Timer (sec) (Cail Request) 200 sec Ye.s 
T22 Timer (sec) (Reset Request) 180 sec Yes 
T23 Timer (sec) (Clear Request) 180 sec Yes 

T24 Timer (sec) (Window Status) 180 sec Yes 
T25 Timer (sec) (Window Rotation) 180 sec Ye.s 
T26 Timer (sec) (Interrupt Response) 180 sec Ye.s 
T28 Timer (sec) (Registration Request) 180 sec Yes 
R22 Counter (reset pkts) 5 

R23 (clear pkts) 5 
R28 counter (reg pkts) 5 
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• Table B-1 Default DTE (continued) 

Parameter Display Value User Configurable 

Packet Level ( contiaued) 
Allow Registration Yes 
Allow Throughput Negotiation Yes 
Automatic Throughput Updating Yes 
RX Default Throughput 9,600 bps 
TX Default Throughput 9,600 bps 

RX Maximum Throughput 48,000 bps 
TX Maximum Throughput 48,000 bps 
Forbid Incoming Calls No 
Forbid Outgoing Calls No 
Allow Reverse Charging Yes Yes 

Forbid Local Charging No Yes 
Allow Fast Select Yes 
Allow D-Bit Usage No 
CUG Subscription Not Allowed Yes 
BCUG Subscription Not Allowed Yes 

Send Restan Pkt on Link Reset Yes· 
DAT AP AC Facility Checking No 

Network Specific Options: 
Allow Data in Call Accept Packet Yes 
Disable D-bit in Call Cong Yes 
Clear Collision Retransmit No 
Use Simple Timer Diag Codes No 
Enforce CCITT Clear Formats No 

Clear on unassigned LUN Pkt No 
Send Reset on PVC Open No 
User Notify on Clear/Reset Yes 

Reserved#) 0 
Reserved #2 0 
Reserved #3 0 
Reserved #4 0 
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• Table B-2 Default DCE 

Parameter Display Value User Configurable 

Internal L2 Parameters 
Auto Start No 
Max Rec Buffers 16 
Min Rec Buffers 4 
Min Free Buffers 10 
Min Free Buffers Timeout (msec) 500 msec 
FIFO FlowControl Limit 4 
Register wilh S.A. No 

AutoCall 
ACU Mode No ACU 
ACU Timer (sec) 0 sec 

Frame Level 
Clock Mode External 
Transmission Speed External 
LAP Mode LAP-B 
Connection Type DCE Yes 
Connection Mode Wait SABM, Send UA Yes 

( 
.. 

Frame Level Module 8 Yes 
Window Size 7 Yes 
T1 Timer (msec) 3000 rnsec Yes 
T3 Timer (sec) 20sec 
T4 Timer (sec) 10sec Yes 
N2 Counter (max error re-xmit) 20 Yes 
DCD Poll Timer (msec) 500 msec 
DCD Retry Counter 2 
XID Pl Timer (msec) 3000 msec 
XID C2 Counter 20 

Network Specific Options: 
Force all FRMR in FRMR state No 
Force RR FRMR in FRMR state No 
Ignore Commands with P IF Bit No 
Disc Answer No 
Disc Action No 
Info Count Escape Yes 
N2 Action Yes 
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• Table B-2 Defauk DCE (continued) 

Parameter Display Value User Configurable 

Internal L3 Parameters 
Highest LCN ( + 1) 
PVC Table Offset 
Max Packet Size 2 
Interface FlowWindow 2 

Packet Level 
Network DNIC 0 Yes 
Network Specification 1984 
Connection Type DCE 1 
Packet Level Modulo 8 Yes 

Default RX Window Size 2 Yes 4 
Default TX Window Size 2 4 
Max Negotiated RX Window Size 7 Yes 5 
Max Negotiated TX Window Size 7 5 
Default RX Packet Size 128 Yes 3 
Default TX Packet Size 128 3 
Max Negotiated RX Packet Size 4096 Yes 2 
Max Negotiated TX Packet Size 4096 2 
l.Dwest PVC Number 1 
Number of PVCs 0 

l.Dwest Incoming SVC !'.'br 1 Yes 
Number of Incoming SVCs 0 Yes 
l.Dwest Two-Way SVC Nbr 1 Yes 
Number of Two-Way SVCs 16 Yes 
l.Dwest Outgoing SVC Nbr 17 Yes 

Number of Outgoing SVCs 0 Yes 
T20 Timer (sec) (Restart Request) 180 sec Yes 
T21 Timer (sec) (Call Request) 200 sec Yes 
T22 Timer (sec) (Reset Request) lOOsec Yes 
T23 Tuner (sec) (Clear Request) 180 sec Yes 

T24 Timer (sec) (Window Status) 100 sec Yes 
T25 Timer (sec) (Window Rotation) 100 sec Yes 
T26 Timer (sec) (Interrupt Response) 100 sec Yes 
T28 Tuner (sec) (Registration Request) 100 sec Yes 
R22 Counter (reset pkts) 5 
R23 (clear pkts) 5 
R28 counter (reg pkts) 5 
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• Table B-2 Default DCE (continued) 

Parameter Display Value User Configurable 

Packet Level ( conttnued) 
Allow Registration Yes 
Allow Throughput Negotiation Yes 
Automatic Throughput Updating Yes 
RX Default Throughput 9 ,(iOO bps 
TX Default Throughput 9,6oo bps 

RX Maximum Throughput 48,000 bps 
TX Maximum Throughput 48,000 bps 
Forbid Incoming Calls No 
Forbid Outgoing Calls No 
Allow Reverse Charging Yes Yes 

Forbid Local Charging No Yes 
Allow Fast Select Yes 
Allow D-Bit Usage No 
CUG Subscription Not Allowed Yes 
BCUG Subscription Not Allowed Yes 

Send Restart Pkt on Link Reset Yes 
DATAPAC Facility Checking ~o 

Network Specific Options: 
Allow Data in Call Accept Packet Yes 
Disable D-bit in Call Cong Yes 
Clear Collision Retransmit No 
Use Simple Timer Diag Codes No 
Enforce CCITT Clear Formats No 

Clear on unassigned LUN Pkt No 
Send Reset on PVC Open No 
User Notify on Clear/Reset Yes 

Reserved tl 0 
Reserved t2 0 
Reserved 13 0 
Reserved t4 0 
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• Table B-3 Tele net 

Parameter Display Value User Configurable 

Internal U Parameters 
Auto Start No 
Max Rec Buffers 16 
Min Rec Buffers 4 
Min Free Buffers 10 
Min Free Buffers Tuneout (msec) 500 msec 
FIFO FlowControl Limit 4 
Register with S.A. No 

AutoCall 
ACU Mode NoACU 
ACU Timer (sec) Osec 

Frame Level 
Clock Mode External 
Transmission Speed External 
LAP Mode U.P-B 
Connection Type DTE Yes 
Connection Mode Wait SABM, Send UA Yes 
Frame Level Modulo 8 Yes 

Window Size 7 Yes 
Tl Timer (msec) 3000 msec Yes • ______ ,.,?' 

T3 Timer (sec) 20sec 
T4 Timer (sec) lOsec Yes 

N2 Counter (max error re-xmit) 80 Yes 
DCD Poll Timer (msec) 500 msec 
DCD Retry Counter 2 
XID Pl Timer (msec) 3000 msec 
XID C2 Counter 20 

Network Specific Options: 
Force all FRMR in FRMR state No 
Force RR FRMR in FRMR state No 
Ignore Commands with P IF Bit No 
Disc Answer No 
Disc Action No 
Info Count Escape No 
N2 Action No 
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• Table B-3 Telenet (continued) 

Parameter Display Value User Configurable 

Internal L3 Parameters 
Highest LCN ( + 1) 
PVC Table Offset 
Max Packet Size 2 
Interface FlowWindow 2 

Packet Level 
Network D!'.1C 3110 Yes 
Network Specification 1984 
Connection Type DTE 
Packet Level Mcx:iulo 8 Yes 

Default RX Window Size 2 Yes 4 
Default TX Window Size 2 4 
Max Negotiated RX Window Size 7 Yes 5 
Max Negotiated TX Window Size 7 5 
Default RX Packet Size 128 Yes 3 
Default TX Packet Size 128 3 
Max Negotiated RX Packet Size 1024 Yes 2 
Max '.'legotiated TX Packet Size 1024 2 

( Lowest PVC Number 1 
Number of PVCs 0 
Lowest Incoming SVC \or 1 Yes 

Number of Incoming SVCs 0 Yes 
Lowest Two-Way SVC \or 1 Yes 
Number of Two-Way SVCs 16 Yes 
Lowest Outgoing SVC Nbr 17 Yes 
Number of Outgoing SVCs 0 Yes 

T20 Timer (sec) (Restart Request) 180 sec Yes 
T21 Timer (sec) (Call Request) 200 sec Yes 
T22 Timer (sec) (Reset Request) 180 sec Yes 
T23 Timer (sec) (Clear Request) 180 sec Yes 
T24 Timer (sec) (1l'mdow Status) 180 sec Yes 

T25 Timer (sec) (Window Rotation) 180 sec Yes 
T26 Timer (sec) (Interrupt Response) 180 sec Yes 
T28 Timer (sec) (Registration Request) 180 sec Yes 
R22 Counter (reset pkts) 5 
R23 (dear pkts) 5 
R28 counter (reg pkts) 5 
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• Table B-3 Telenet (continued) 

Parameter Display Value 

Packet Level (cmdlued) 
Allow Registration Yes 

Yes 
Yes 

144 

Allow Throughput Negotiation 
Automatic Throughput Updating 
RX Default Throughput 
TX Default Throughput 
RX Maximum Throughput 
TX Maximum Throughput 

Forbid Incoming Calls 
Forbid Outgoing Calls 
Allow Reverse Charging 
Forbid Local Charging 
Allow Fast Select 

Allow D-Bit Usage 
CUG Subscription 
BCUG Subscription 
Send Restan Pkt on Link Reset 
DATAPAC Facility Checking 

Network Specific Options: 

9,6oo bps 
9,6oo bps 
48,000 bps 
48,000 bps 

No 
No 
Yes 
No 
No 

No 
Not Allowed 
Not Allowed 
No 
No 

Allow Data in Call Accept Packet Yes 
Disable D-bit in Call Cong Yes 
Clear Collision Retransmit No 
Use Simple Timer Diag Codes No 
Enforce CCITT Clear Formats No 

Oear on unassigned LUN Pkt No 
Send Reset on PVC Open No 
User Notify on Clear/Reset Yes 

Reserved 11 0 
Reserved 12 0 
Reserved 13 0 
Reserved 14 0 
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Yes 
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• Table B-4 TRANSPAC 

Parameter Display Value User Configurable 

Internal L2 Parameters 
Auto Start No 
Max Rec Buffers 16 
Min Rec Buffers 4 
Min Free Buffers 10 
Min Free Buffers T!IDeout (msec) 500 msec 
FIFO FlowControl Limit 4 
Register with S.A. No 

AutoCall 
ACU Mode No ACU 
ACU Timer (sec) 0 sec 

Frame Level 
Clock Mode External 
Transmission Speed External 
W Mode LAP-B 
Connection Type DTE Yes 
Connection Mode Send SABM, Wait UA Yes 
Frame Level Modulo 8 Yes 

Window Size 7 Yes 
Tl Timer (msec) 1600 msec Yes 
T3 Timer (sec) 20 sec 
T4 Timer (sec) 10 sec Yes 
N2 Counter (max error re-xmit) 20 Yes 
DCD Poll Timer Cm.sec) 500 msec 
DCD Retry Counter 2 
XlD Pl Timer (msec) 3000 msec 
XlD C2 Counter 20 

Network Specific Options: 
Force all FRMR in FRMR state Yes 
Force RR FRMR in FRMR state No 
Ignore Commands with P IF Bit No 
Disc Answer No 
Disc Action No 
Wo Count Escape No 
N2 Action No 
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MacX25 Parameters 

T Hffi APPENDIX CONTAINS A BRIEF DESCRIPTION OF EACH PARAMETER DffiPLAYED 

by the MacX25 Admin program when you open a parameter file. The 

appendix contains a section for each parameter group. Within each section, 

you can find information about each parameter that you can set within that 

parameter group. 

These descriptions are brief. If you need more information about a specific 

parameter, you can contact a representative of the packet-switched data 

network to which you suh5cribe, or you can refer to the CCJIT 

Recommendation X.25 or the International Standards Organization's (ISO) 

recommendations. 
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Line type 

Network ID 

User groups 

Addressing parameters 

X.25 communications are between data terminal equipment (DTE) and data 
communications equipment (DCE). The MacX25 server acts as a DTE or as a 
DCE, depending on how you set this parameter. 

The first four digits of the Network ID uniquely identifies the packet­
switched data network. For example, the four-digit ID for Telenet is 3110 
hexadecimal (hex). 

The remaining digits uniquely identify the MacX25 server on the packet­
switched data network. The network vendor assigns this address and uses 
it to deliver packets to the MacX25 server. 

Many X25 network vendors offer closed user group (CUG) and bilateral 
closed user group subscriptions. 

Closed User Group (CUG) 

packet-switched data network vendors provide a variety of closed user 
group subscriptions, which include: 

• no closed user groups allowed 

• closed user group with incoming and outgoing access without 
preferential 

• closed user group with outgoing access without preferential 

• closed user group incoming access without preferential 

• closed user group with incoming and outgoing access with preferential 

• closed user group with outgoing access with preferential 

• closed user group with incoming access with preferential 

• closed user group with preferential 
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When a user belongs to a closed user group, the user can only place X.25 calls 
to or receive X.25 calls from other members of the same group, depending on 
the type of subscription that you have. 

The MacX25 product supports all of these closed user group options. 

Bilateral Closed User Group (BCUG) 

A binary closed user group is a special type of clo.sed user group that allows 
only two members. The MacX25 product supports bilateral closed user 
groups. 

Channel Allocation parameters 

A logical channel number (LCN) i.s a value that uniquely identifies each virtual 
circuit on the X.25 link. 

When the MacX25 server acts as the DTE, the MacX25 server assigns the LCN 
for each call that originates from one of its MacX25 users. When the MacX25 
server acts as the DCE, it assigns the LCN for each call to a MacX25 user that 
originates at the remote end. 

MacX25 Admin allows you to allocate up to 64 logical channel numbers 
(LCNs) among the three types of channels that MacX25 supports. The 
MacX25 product supports: 

• outgoing channels 

• two-way channels 

• incoming channels 

The MacX25 server's Channel Allocation settings must match the channel 
allocation settings that the network uses. MacX25 Admin does not allow 
you to overlap the range of any two channel types or to specify a range out 
of the required order. 
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Outgoing channels 

Two-way channels 

Incoming channels 

Permanent virtual circuit 
(PVC) channels 

An outgoing channel is a channel on the X.25 link that the MacX25 server uses 
for calls that originate locally and that cannot receive incoming data from the 
remote end of the connection. 

Outgoing channels require the highest logical channel numbers that the 
MacX25 server uses. 

A two-way channel is a channel on the X.25 link that the MacX25 server uses 
for calls that can originate from either the local or the remote end <i the 
connection and that can send and receive data. 

Two-way channels must have logical channel numbers that are lower than 
the LCNs used by the outgoing channels and that are higher than the LCNs 
used by the incoming channels. 

An incoming channel is a channel on the X.25 link that the MacX25 server uses 
for calls that originate from the remote end of the connection and that 
cannot send data to the remote end of the connection. 

Incoming channels must have logical channel numbers (LCNs) that are lower 
than the LCNs used by the two-way channels. 

A permanentvirtual circuit (PVC) channel is a channel on the X.25 link that is 
permanently assigned and that remains connected at all times. 

Because MacX25 Adrnin does not support pennanent virtual circuits, you 
cannot allocate any PVC channels. 

Charging options 

MacX25 Admin provides options to allow reverse charging and to prevent 
local charging. 
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Allow Reverse Charging 

Prevent Local Charging 

Window settings 

APPLE CONFIDENTIAL 

When you select Allow Reverse Charging , a MacX25 user can make a 
connection and bill the call to the destination host. 

When you select Prevent Local Charging, a remote caller cannot make a 
connection to a MacX25 user and charge the call to the Macxi~ server. 

Frame Level parameters 

The Frame Level parameter group contains parameters that affect how the 
MacX25 server handles operations at the frame level. Frame Level parameters 
include window settings, frame level timer settings, and a connection mode 
specification. 

You can find information on all of the Frame Level parameters except T4 in 
the CCJIT Recommendation X.25, also known as the Redbook. The 
International Standards Organii.ation (ISO) defines the T4 timer. ' 

MacX25 Admin allows you to specify the Maximum Size window and the 
Modulo that the MacX25 frame level software uses. These parameters 
appear in the Window box in the Frame Level parameter group. 

Maximum Size 

The Maximum Size parameter sets the maximum number of frames that the 
server can send or receive without acknowledgment. 

If the MacX25 server's frame level software uses Modulo 8, you can set the 
maximum window size to any value from 1 through 7. If the MacX25 
server's frame level software uses Modulo 128, you can set the maximum 
window size to any value from 1 through 127. 
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Connection Modes 

Timers 

Modulo 

The Modulo parameter specifies the numbering system that the MacX25 
server's frame level software uses. MacX25 Admin supports both the 
Modulo 8 and Modulo 11.8 numbering schemes. 

MacX25 supports two connection modes, Wait for SABM and Send SABM. A 
SABM is a type of packet that the local and remote X25 frame level software 
exchanges to establish a new virtual circuit. 

Send SABM 

If the network expects the MacX25 server to send the SABM, you must set 
the MacX25 server's Connection Mode parameter to Send SABM. 

Wait for SABM 

If the network sends the SABM, you must set the MacX25 server's 
Connection Mode parameter to Wait for SABM. ' 

The Frame Level parameter group includes a Timers box that contains the Tl, 
T4, and N2 parameter settings. 

Tl 

The Tl parameter indicates the number of SO millisecond units that occur 
before the MacX25 server retransmits a frame. For example, if you enter 60 in 
the text edit box for this parameter, you are specifying 3000 milliseconds, or 3 
seconds. 

T4 

The T4 parameter specifies how many seconds the MacX25 server waits for 
an event to occur on the line before the MacX25 server sends a Receiver Ready 
(RR) frame to the network. You can disable this timer by setting its value to 
zero. 
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N2 

The N2 parameter specifies the maximum number of times that the MacX25 
server can retransmit a frame under error conditions before the MacX25 
server resets the link. 

Packet and Window Size parameters 

The Packet and Window Size parameter group contains parameters that 
affect how the MacX25 server handles operations at the packet level. You 
and your network vendor must agree to these settings when you subscribe 
to the network. 

The Packet and, Window Size parameter group contains a Packet box that 
contains Default Length and Maximum Length parameter settings, 

Default Length 

The Default Length parameter specifies the packet length that the MacX25 
·server normally uses. 

You can choose a default packet length of 32, 64, 128, 256, 512, 1024, 2048, or 
4096. The Maximum Length parameter setting affects Default Length 
setting that you can choose. For example, you cannot choose a Default 
Length !.hat is larger !.ban !.he Maximum Length. 

MacX25 Admin uses a pop-up menu to display the Default Length options to 
you. MacX25 Admin dims any options in the menu that you cannot choose. 

Maximum Length 

The Maximum Length parameter specifies the largest packet length that the 
MacX25 server can send or receive . 
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Window settings 

You can set the Maximum Length to 32, 64, 128, 256, 512, 1024, 2048, or 40%. 
The Default Length parameter setting affects Maximum Length setting that 
you can choose. For example, you cannot choose a Maximum Length that is 
smaller than the Default Length. 

MacX25 Admin uses a pop-up menu to display Maximum Length options to 
you. MacX25 Admin dims any options in the menu that you caMot choose. 

The Packet and Window Size parameter group includes a Window box that 
shows the settings of the Default Size, Maximum Size, and Modulo 
parameters. 

The MacX25 server uses the window parameters to determine the number of 
packets that the MacX25 server can send to, or receive from, the network 
without confirmation. 

Default Sil.e 

The default size parameter specifies the window size that the MacX25 server 
uses when it does not negotiate a window size with the network. 

If the MacX25 server uses Modulo 8, you can set the Default Size parameter 
to any value from 1 through 7. If the MacX25 server uses Modulo 128, you 
can set the Default Size to any value from 1 through 127. ,, · // 

The Maximum Size parameter setting also affects Default Size setting that 
you can specify. For example, you caMot specify a maximum window size 
that is smaller than the default window size. 

Maximum Size 

The Maximum Size parameter specifies the largest window size that the 
MacX25 server can use. 

If the MacX25 server uses Modulo 8, you can set the maximum window size · 
to any value from 1 through 7. If the MacX25 server uses Modulo 128, you 
can set the maximum window size to any value from 1 through 127. 

The Default Size parameter setting also affects Maximum Size setting that 
you can specify. For example, you caMot specify a maximum window size 
that is smaller than the default window size. 

156 MacX25 Administrator's Guide - Beta Draft 5/31/89 APPLE CONFIDENTIAL 



( 

( 
T20 

T21 

T22 

APPIE CONFIDENTIAL 

Modulo 

The Modulo parameter specifies the numbering system that the MacX25 
server's packet level software uses. MacX25 Admin supports both the 
Modulo 8 and Modulo 128 numbering schemes. 

Timers 

The Timers parameter group displays the current settings for the T20, T21, 
T22, T23, T24, T25, T26, and T28 packet-level timers. You should negotiate 
these values with your network vendor before setting them in the MacX25 
parameter file 

You can find information on the T20, T21, T22, T23, and T28 timers in the 
CCITT Recommendation X.25, also known as the Redbook. The 
International Standards Organization (ISO) defines the T24, T25, and T26 
timers. 

The T20 timer specifies how many seconds after the MacX25 server sends a 
restart request that it waits for a restart confinnation or indication before 
sending another restart request 

The T21 timer specifies how many seconds after sending a call request that 
the MacX25 server waits for a call connected, clear indication, or incoming call 
before the MacX25 server sends a clear packet. 

The T22 timer indicates how many seconds after sending a reset request that 
the MacX25 server waits for a reset confirmation or reset indication before 
retransmitting the reset request packet. 
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!28 
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The 1'23 timer detennines the number of seconds after the MacJC25 server 
sends a clear request that it waits for a clear confirmation or clear indication 
before it retransmits the clear request packet. 

The 1'24 timer sets the number of seconds after sending an acknowledgment 
that the MacX25 server waits before it sends a Receiver Ready (RR) packet. 

The T25 timer specifies the number of seconds after sending a data packet 
that the MacX25 server waits for an acknowledgment before resetting the 
virtual circuit. 

The T26 timer indicates how many seconds after the MacX25 server sends an 
interrupt packet that it waits for the interrupt confirmation before resetting 
the virtual circuit. 

The 1'28 timer indicates the number of seconds after sending a registration 
packet that the MacX25 server waits for a confirmation before it resends the 
registration packet. 
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Messages that May Appear in the Log 

THIS APPENDIX CONTAINS A TABLE TIIAT LlSTS TilE MESSAGES TIIAT MAY 

appear in the MacX25 Log window. The table shows the message and, if the 

situation requires you to perform an action, indicates what you should do . . 
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1 • Table D-1 MacX25 Ad.min log messages 

What appears in the log 

Messages about the MacX25 Admia program or its mes 
MacX25 Admin Program Started. 
Begin administration session. 
End administration session. 
X25 protocol stack file "<filename>" not found. 

No X.25 cards installed. 

No Apple IPC installed. 

Out of MRDOS message buffers. Fatal Condition. 
Server Agent not available. 

Messages about a MacX25 Server 

"<Server name>" Started. 
"<Server name>" Stopped. 
Server "<Server name>" Created. 
Server "<Server name>" Modified. 
Server "<Server name>" Deleted. 

What you should do 

Quit MacX25 Admin. 
Oieck for file. (See Olapter 2). 
Quit MacX25 Admin. 
Install card (See Chapter 2). 
Quit MacX25 Admin. 
Check for file. (See Chapter 2). 
Restart the Macintosh. 
Quit MacX25 Admin. 
Check for file. (See Chapter 2). 

Server "<Server name>" Shutdown. User "<User name>" Logged Out. 
Server "<Server name>" <number> minute shutdown warning sent to <number> users. 
Server "<Server name>" shutdown canceled. 
Attempt to start "<Server name>" failed. Start server again 
Server "<Server name>" start cancelled. 

Server Claim Server mStatus = <status code>. 
Server "<Server name>" access status request received, respond with accessBits =<hex value>. 
X25 download error <error code>. Start server again. 
Get MacX25 MRDOS TID failure. Start server again 
X25 IPC communications lost. Link table download failed Start server again 
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• Table D-1 MacX25 Admin log messages (continued) 

What appears in the log 

Messages about a MacX25 Server (continued) 

X25 IPC communications lost. Server start message failed. 
Send client note mStatus = <status code>. 
X25 IPC communications lost. Server stop message failed. 
X25 IPC communications lost. Claim Server message failed. 
X25 IPC communications lost. Quit Claim Server message failed. 

Server Quit Claim Server mStatus = <status code>. 
X25 !PC communications with Server Agent lost. 
Death Notice received for "<Server name>", not in service. 
Death Notice received for "<Server name>". 

Messages about a MacX25 User 

User "<User name>" Logged In <Server name>. 
User "<User name>" Logged Out <Server name>. 
Logout Attempt Failed: No user with vcid =<ID of virtual circuit>. 
User "<User name>" Created. 
User "<User name>" Modified. 

User "<User name>" Deleted. 
User "<User name>" changed password. 
User "<User name>" changed password attempt failed. 

Messages about the Master Address Book 

Address Book 'Get List' request. 
Address Book 'Get Entry' request. 

What you should do 

Start server again 

Start server again 
Start server again 
Start server again 
Start server again 
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• Table D-1 MacX25 Admin log messages (continued) 

What appears in the log 

Messages about a MacX2S parameter fl.le 

Parameter file: •<Parameter filename>" not found. 

<Parameter fdename> Parameters opened. 
<Parameter filename> Parameters modified and saved. 
<Parameter filename> Parameters file created. 
<Parameter filename> Parameters file closed. 

What you should do 

Select a new ftle for server, or 
quit MacX25 Admin.and 
check for file (Chapter 2). 

Unsupportable configuration( <hexadecimal value>). System Table Download Failure. Contact Apple. 

Messages about a connectio.o. 

Login Attempt Failed. User "<User name>" does not have access to Server "<Server name>". 
Login Attempt Failed. User "<User name>" invalid password. 
Login Attempt Failed. Server "<Server name>" unknown. 
Login Attempt Failed. User "<User name>" unknown. 
Validation Attempt Failed. Server "<Server,name>" unknown. 
Validation Attempt Failed. User <User name> unknown. 
Users <User name> virtual circuit (<ID of virtual circuit>) unknown. User logged out. 

<Server name> - the name of the server appears here. 
<User name> - the name of the user appears here. 
<Parameter filename> - the name of the Parameter ftle appears here. 
<ID of virtual circuit> - the value that identifies the virtual circuit appears here. 
«hexadecimal value» -a hexadecimal number appears here. 
<status code> - a program status code appears here. 
<number> -a decimal number appears here. 
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MacX25 server status and slot 
conditions 

T ms APPE,Dll< sHows How MACX25 ADMIN REPRESENTS SERVER mm AJm 

slot conditions. 

Although slot condition and MacX25 server status are related, the condition 

of a slot may not exactly reflect the status of a MacX25 server, and vice-

versa. 

For example, you can save a MacX25 Server information window without 

assigning the server to any slot in the Macintosh. As another example, a slot 

appears Ready to Start when you select the slot. The status of the MacX25 

server is Ready, however, only after you save the information. 
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MacX25 slot conditions 

MacX25 Admin makes uses a picture to represent the NuBus slots in the 
Macintosh gateway, and to show the condition of each slot. The slot 
picture appears.in each Server information window that you display on your 
screen when you are working in MacX25 Admin's administration mode. The 
same slot picture appears in the MacX25 Admin window when the program 
is in its information mode. 

By the way a slot appears , you can tell whether or not the slot contains an 
Apple Serial card, and you can tell the current state of the MacX25 software 
on a slot that does contain an Apple Serial Card. Figure E-1 shows how 
MacX25 Adrnin represents each possible slot condition. 

• Figure E-1 MacX25 slot conditions 

Empty 

~ klM 'lliih ponding""• 

~ a.w'lliih p1nd1ng ""• 
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MacX25 server status 

Server status information appears in the MacX25 Server List window when 
you are working in administration mode. When MacX25 Admin is in 
information mode, the Servers list box in the MacX25 Admin window shows 
the state of the server 

• Table E-1 MacX25 server states 

Server state 

Out Of Service 

Ready 

Started 

Signals High 

Active 

Active, Stop[ <stop setting>) 

Busy( <number>) 

Associated slot condition 

Not assigned (to a slot) 

Ready to start 

Active 

Active 

Active 

Active with pending stop 

Busy 

Busy(<number>),Stop[<stop setting>) Busy with pending stop 

<stop setting> - the number of minutes set for the stop appears here. 
<number> - the number of virtual circuits that the MacX25 server is currently 

supporting appears here. 
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Glossary 

actift coonecdo.n: A successful line of communication 
between points. 

Active: The status of the MacX25 server after you have started 
the server and when no users have X.25 connections on that 
MacX25 server. 

addreu file: A file that the Open Book appliatioo creates. 

Addresses: The ftle that Open Book automatically creates 

and displays when you launch the Open Book application 
from your desktop or when certain programs. like MacP AD 
or Chooser, use Open Book. 

admfnfstradoJl mode: The way you use MacX25 Admin 
when you are making changes to the MacX25 gateway. To 
puc MacX25 Admin into administration mode, you muse type 
an admin key. Compare with info.rmation mode. 

ADSP: Macintosh software that implements the AppleTalk 
Daca Stream Protocol. 

American St2ndard Code fot Informadoll Intercbange 
(ASCII): A syscem for representing the keyboard cliatacteis, 
control characteis, and certain graphics elements as numeric 
values. 

Apple IPC: Software that handles communications between 
the Macintosh and the software running on the Apple Serial 
NuBus Card. 

Apple Serial NuBus Card: An intelligent communications 
card for the Macintosh II family computer. Some of the 
MacX25 Server soCtware runs on this aid. 

AppleShare: MaridOlb software that allows Macintosh users 
on an AppJeT~ DllWOrk sysrem to share files and p~ograms 
by vewing mi c:ap,iDa files that reside at an AppleShare file 
server. 

AppleTalk Dita Stram Protocol: A connection-Oriented 
protocOI that provides in-<>rder delivery of data on an 
AppleTalk inremet. 

AppleTalk .aetwork system: The system of network software 
and hardware used in various implementat.iom of Apple's 
communications network. 

AppleTalk network: See AppleTalk network system. 

AppleTalk mae: A subset of the networks within an internee. 
Z.Ones within an AppleTalk internet are joined by iltemet 
routers. 

appllc:adon or applladoo program: A program written 
for some specific purpose, such as word processing, database 
management, graphics, or telecommunication. 

ASCII: See American Standard Code for Information 
Interchange. 

Auto Start check bm:: In MacX25 Admin, an item on the 
MaclC25 server information window that allows you to specify 
whether MacX25 Admin automatically stares the MacX25 
server when you launch MacX25 Admin program. 

Anilable: In MacX25 Admin, a candili>n of the NuBus slot 
oo the Macintosh computer. When a sltt is available, you 
can :wign a MacX25 server to run on the Apple Serial NuBus 
Card that resides in that slot 

back up: (v.) To make a spare copy of a disk or of a file. 
backup: (n.) A copy of a disk or ftle. 

blckgrouad: A program oper2tes "in the background• if it 
continues to function, automatially, while you use another 
program. 

BCD: See binary code decimal. 

BCUG: See bilalera1 closed user group. 
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bilateral doled mer group: A subscription service that 
many X.25 network 'Veftdas offer. A bilateral dosed user 
group is a special type of closed user group that allows only 
two members. The MacX25 product supports bilateral closed 
user groups. 

binary code dedmal: 

binary: The representation of numbers and other characters 
in the ba.se-2 system, using only the two digits 0 and 1. 

break sigDal: A keystroke available on the keyboard of some 
terminals and personal computers. This key is not available 
on the Macintosh keyboards. 

Busy: The status of the MacX25 server after you have started 
the server and users have X.25 connections on that MacX25 
server. This status includes the number of connections. For 
CJ1am.ple, Busy(2) indicates that the MacX25 server has two 
connectfons. 

CCTIT: See Consultative Committee on International 
Telegraphy and Telephony. 

choose: To pick a command by dragging the cursor 
through the menu. You often choose a command after you 
have selected something on which the program will execute 
the command. 

Chooser document: A ftle that contains Wormation that the 
Chooser desk accessory uses to display options to you. 

Chooser: A desk accessory that is normally installed with 
I.aserWrit~, LaserWriter Plus, and lmagewrit~ printer 
software. This desk acces.rory can also be expaixled by 
adding other chooser documents, such as AppleShare and 
X.25. The Chooser displays icom from each ch~ 
document. When you select a printer icon, you can choose 
the printer that you want to use. When you select the X.25 
icon, you can choose a MacX25 server to use for X.25 
connections. 

click: To select DDetbing from a program display by 
putting your curaar oo the item and then pressing and 
releasing your mouae button once. 

Clipboard: The OOlding place for the item you last cut or 
copied. 
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dosed user group: A subscription service that many X.25 
network vendors offer. When a user belongs to a closed user 
group, the user can only place X.25 calls to <X receive X.25 
calls from other members of the same group. The MacX25 
product supports closed user groups. 

CommUDicatioas Toolbox: Macintosh system software that 
SJJpports multiple types of connectiom, terminals, and file 
transfer methods. The Macintosh syscem version 6.03 and 
later includes the Communications Toolbox as part of the 
System file, and provides a Communications folder with 
several connection tools, terminal tools, and file transfer tools. 
MacPAD is a connection tool for the Communicatiom 
Toolbox. 

configure: A catch-all term for many tasks on a computer 
or network. "To configure a program• means to choose 
options for the program's standard features. "To configure a 
connection• means to choose the type of connection you 
want to make, the host or program to which you want to 
connect, and the parameter settings that allow your 
Macintosh to talk to the renx>te destination. 

connection maintenance: Any action that affects the current 
state of a connection. 

connection met.bod: A type of connection. The 
Communicatiom Toolbox allows you to choose from several 
connection methods, such as serial (through a phone line 
using a modem) or MacPAD (through an X.25 link using a 
MacX25 server). 

connection tool: A program that handles a parti:ular type 
of connection and that uses the Communications Toolbox to 
display this connection option to you. 

connector port: Ahardwarereceptacleiruowhlmyoucw 
plug a cable connector. The Macintosh is equipped with 
serial and SCSI ports. Some communications cards for the 
Macintosh II family, such as the Apple Serial NuBus Card, 
have a connector port for connecting specialized cables to 
the card. 

Consulbdve C.Ommittee on International Telegraphy 
and Telephony Cccrrn: An organization, based in Geneva, 
Switzerland, which recommends international standards for 
communications. 
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C.oatrol Paa.el datce 8le: A file that contains information 
that the Comrol Pmd desk accessory uses to display options 
to you. 

coatrol cbaracter: On ProDOS and MS-DOS computers, a 
nonprinting character that controls or modifies the way 
information is prinled or displayed. Control characters are 
typed by OOlding down the Cootrol key while pressing some 
other key. In the Macmu.h family, the Command key 
perfonm a similar function. 

control function: A command that you issue by pressing 
one or more keys on your keyboard. 

CUG: See closed user sroup. 
current startup disk: The disk that cattains the system files 
that the computer is currently using. The startup disk icon is 
usually in the upper-right· comer of the desktop. 

elm commuaicado.as equipment (DCE): A devke or 
program that perfonns one end of the communications on 
an X.25 link. Normally, a network computer acts as the DCE. 
Compare with data terminal equipment (DTE). A MacX25 
server can act as a DCE or as a DTE on the X.25 link. 

elm network ID code: 

elm termfaa1 equipment (DI'E): A device or program that 
performs one end of the communicatiom on an X.25 link. 
Normally, a user's terminal or pets0nal computer acts as the 
DTE. Compare with data communications equipment 
(DCE). A MacX25 server can act as a DTE or as a DCE on the 
X.25 link. 

DCE: See data communications equipment. 

desk accessories: "Mini-applications• that are available 
from the S menu regardless of which application you are 
using. 

desktop: The Madntosh computer's working environment; 
the menu bar and the py area on the screen. You can have 
a number of documenr.s on the desktop at the same time. At 
the F"mder level, the daktop displays the Trash icoo, the icons 
of disks, and the wtmows of any files or programs that you 
have opened. 

dial-up COIUlecdon: A type of connection which you 
accomplish by connecting the Apple Serial NuBus Card to a 
modem, starting the MacX25 server, and then dialing the 
telephone number of a network computer. 

dialog bo:K: A box that a Macintosh application displays and 
that contains one or more items (such as buttons or pop-up 
menus> that you can use to perform actions. 

disk drift: The mechanimi that oolds a disk, retrieves 
information from it, and saves infonnation to it. A hard disk 
drive has the disk permanently encased. A 3.5-inch disk drive 
requires that you insert a 3.5-inch disk. 

double-clic:k: To select something from a program display 
by putting your cursor on the item and then pressing and 
releasing your muse buttoo twice in quick succession 
without moving the mouse. This usually selects the item and 
opens i. 

DTE: See data terminal equipmett. 

Empty: In MacX25 Admin, a condition of the NuBus slot on 
the Macintosh computer. When a slot is empty, the slot does 
ooc have an Apple Serial NuBus Card installed in it. 

entry: A record Cran an address file. An entry contains the 
name of a host, which you see in Open Book's upper-left list 
box, and two reaxds with infonnation that a program, like 
MacPAD, needs to establish a camection to that host. Open 
Book provides an Edit button that you can use to view the 
information in the records of an entry. 

fUe tnlllfer medlod: A specific procedure for transferring 
f.des between two remote computers. The Communications 
Toolbox allows you to choose a file transfer meUxxi 

file tn.asler tool: A program thac performs a particular 
type of file transfer and that uses the Canmunications 
Toolbox co display the file transfer option to you. 

Blename: The name that idettifies a file. The maximum 
character length of a Macincosh f.dename is 31 characters for a 
OOcumen1 or folder, Tl characters for a disk. A name can't 
a>nrain a colon (:), and iC should not begin with a period (.). 

Finder: Maciilosh system software that displays files and 
progmns on your desktop. 
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hard disk: A permanently encased storage area on the 
Macintosh. 

hierarcbkal fUe S'fltem (BFS): A fonn of computer 
meroory organization in which files, including folders, can be 
nested within folders. 

host computer: A computer that conrains a program or 
programs that you want to use. 

host vendor: A company that provides savices from a oost 
computer. 

host: A computer that conrains a program or programs that 
you want to use. 

icon: An image that graphically represents an object, a 
· concept, or a m~ge. For example, AppleShare is 

represented by a hand holding files, folders, and programs. 

Jnformation mode: The way you use MacX25 Admin 
when you are not making changes to the MacX25 gateway. 
When you launch MacX25 Admin, the program opens in 
information mode. Compare with administration mode. 

internet: Two or more networks interconnected by bridges 
to form a larger network. Network users in an internet can 
share information and network devices. 

InterProcess Communications: Macintosh software that 
handles communications between the Macintosh system 
software and the software that runs on the Apple Serial NuBus 
Card. 

invert: To change a portion or all of your Macintosh screen 
so it appears as white on black instead of as black on white. 

inwke: To call for support A program often invokes one or 
more ocher programs to handle certain tasks. For example, 
MacP AD calls Open Book to display a list of lx>ru when you 
are either configuring your connecti>n or making a call. 

IPC: See 11l1erProcess Communiations. 

K: An abbreviation for kilo, which means one thousand. 

KB: An abbrevialim for kilobyte, which is equal to 1024 bytes. 

launch: To put info actiJn. When you open a program, you 
are launching it. 
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LCN: See logical channel number. 

link: An available line of communication between an entry 

point into a packet-switched data network (usually called data 
communieations equipment (DCE)) and an end point 
(usually called data terminal equipment (DTE)) that is not 
part of the packet-switched data network. With MacX25, the 
MacX25 server supportS an X.25 link. MacJQS users on the 
AppleTalk netWOrk can share this link., using it to connect to 
006t computers on the packet-switched data network. 

logical channel number: (LCN) A number that X.25 
communications software assigns to each new virtual circuit 
that the MacX25 server establishes. The DTE on an X.25 link 
assigns the LCN for each call that originates locally. The DCE 
on an X.25 link assigm the LCN for each call that criginates at 
the remote end. 

MacPAD: A connectX>n tool program that you can use to 
communicate with host computers that are connected to an 
packet-switched data network. To succCMfully make or 
receive calls with MacPAD, you must have accCM to a MacX25 
saver on the AppleTalk network; you must be usin3 a 
terminal program that uses the Communications Toolbox; 
and you must have login privileges with the host computer 
that you want to use. 

MacX25 Admin program: A program that you use to set up 
and manage the MacX25 savers on the AppleTalk network 
system. 

MacX2S Admin window: A window that MacX25 Admin 
displays when the program is in information IOOde. This 
winOOw contains information about the activity of the 
MacX25 savers in the MacX25 gateway. 

MacX25 Folder: A folder that contains the MacX25 Admin 
program and all of the files that this program uses. 

MacX2S gateway: In the case of MacX25, a Macintosh II 
family computer that supports one or mre MacX25 servers 
fer the AppleTalk nerwork ~em. 

MacX25 Serret dJsk: The 3.5-inch floppy disk that contains 
all of the files and programs that you need to set up the 
MacX25 gateway. 
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MacX25 laftr: 1he hardware and software required to 
support one X25 Bak between an Apple Serial NuBus Card in 
a Mac:inlosh D &mi, computer and a netWork computer of a 
packet-switched network computer. If the Macintosh is 
connected to an AppleTalk networlc: system, other Macintosh 
ccxnpute!S on the AppleTalk network can use the X.25 link 
provided by the MaciC25 server to connect to a remote host 
on the X.25 network. 

MacX25 SerftrS Ole: The rile that MaciC25 Admin creates 
and in which it stores the admin key and any information on 
a MaciC25 server that you save. 

MlcX25 User disk: The 3.5-inch floppy disk that contaim 
the files and programs that allow the Macintosh to gain ace~ 
to the MaciC25 servers on the AppleTalk network. 

MacXlS Users 8le: The file that MaciC25 Admin creates and 
in which it stores any infonnatioo. on a MaciC25 user that you 
save. 

MacX25: A product that allows Macintosh computers on an 
AppjeTalk network sysr.em to gain access to a packet-switched 
data networlc:. MaciC25 includes MaciC25 Server and MaciC25 
User software. 

Master Addral Book: An address file that Open Book 
creates and displays when the MaciC25 Adm.in program uses 
Open Book. When thb rile is available on the MaciC25 
gareway, a MaciC25 user can use the Omser desk acceswry 
to copy MaciC25 addresses from the Master Address Book to a 
local Addresses file. 

mmu Im: The horizonral strip at the top of your screen that 
contains pull-<lown menus. 

menu: A list of~ that appears when you point to a 
menu title and hold your mouse button down. 

modf&r key: A key that you press in combination with a 
readable characrer to cbange its meaning. Sometimes you 
press a uxxtifier key to cbange the ac:ti>n of cl.icking or 
dragging. En"'P"I d modifier keys are Command and 

Option. ·-

network addrm: Por a tDSt canputer that is conneaed to 
a packet-swtthed dlra network, the netWak address 
normally consists of a sequence of alphanumeric charatters. 

.aetwork admimatntot: A person who manages the 
hardware and software that connects computers in a network. 
With MaciC25, the network administrator is responsible for 
manasin8 the MaciC25 servers and the X.25 linlrs that they 
support, and may also be responsible for managing the 
AppleTalk network system through which the MaciC25 User 
software operites. 

mtwork swftc:b: A network ccxnputer within a packet­
swilched data network. 

mtwork 'ftlldor: A company that provides services from a 
network. 

NuBu1 slot: A connector inside a Macintosh D family 
computer's main unit that allows you to install expansion 
cards to enhance the computer's peiformance. 

<>pm Book: An appllation that displays informatioo from 
an address flle, like Addres,,es, and that allows you to edit an 
address me. 
packet wembler clfauembler (PAD): A program that 
assembles ourgoing characters from a user device into X.25 
packets for network ~i>n; and that disassembles 
incoming X.25 packets into characters for the user devi:e to 
display (or process). 

packet-switc.bl!d data network (PSDN): A network that is 
specifically desiened for transferring data between numerous 
source and destination points connected to the netWork. 
Telenet is one well-known example of a packet-swiched data 
network. 

pldra-nritcbed wide area data network: See packet­
swilched dara network. 

packet: See x.25 packet. 

PAD panmeters: The system of repating the characteristics 
of the terminal to a remote host computer. PAD parameters 
and their pcmible settinp are defined in the CCnT X.3 
recommendation. 

PAD: See packet assembler disawmbler. 
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parameter groap: MacX25 Ad.min groups the X.25 
parameters whose ·xu.inp you can change into parameter 
groups, and displays one parameter group in the parameter 
information window. The window has a pop-up menu that 
you use to view the choose to parameter group that you want 

to see. 

parameter iaformadoa window: The window that MacX25 
Admin displays when you clXX>.Se the Open Parameter File 
command in the File menu. This command appears in the 
File menu only when MacX25 Admin is in administration 
mode. 

parameter setting: The value assigned to a parameter. 

pencil icon: An icon that appears in front of records in Open 
Book's upper-riaht list box. If the pencil is dimmed, you 
canoot examine the contents of the record. If the pen:il is 
not dimmed, you can select the record and edit its contents. 

permanent 'rirtual drcuit: A pennanent virtual circuit is 
permanently assigned to a specific device and remains 
connected at all times. MacX25 does not support permanent 
virtual circuits. 

PVC: See permanent virtual circuit. 

RAM: See random access memory. 

random-access memory (RAM): The part of a ccmputer's 
memory that stores programs and other information 
temporarily while you're waking with it. 

read only memory (ROM): The part of the computer's 
memory that contains information that the computer uses 
throughout the system. For example, the system files and the 
programs that the computer uses to get itself started are stored 
in ROM. Information in ROM is permanent; it doesn't vanish 
when you switch the power off. 

ReadMe: A file that contains information about the progrum 
and files on the disk on which you find it. 

Re2dy to swr: In MacX25 Admin, a condition of the NuBus 
slot on the MNidolb axnputer. A slcx is ready to start after 
you assign a MacX25 aem:r to the slcx. 
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record: A place where Open Book stores information about 
an address book entry. Maci'25 entries have an x.25 
Connection record and an X.25 Server record. 

remote bolt computer: A computer that is connected to a 
packet-switched data netWork and that you access through 
the network. 

remote host See remote host computer. 

llOM: See read only memory. 

sdect: To designate where the next actbn will take place. To 
select, you click an icon or drag across information. 

serial connection: A coonection in which information is 
transmitted sequentially, a bit at a time, over a single wire or 
channel. 

Sena- Agent: A program that perfonns actions for the 
Maci'25 servers. 

Sena- list window: In Mac}C25 Ad.min, a window that lists 
ail of the Maci'25 servers in the Maci'25 gateway. You can 
display t.hn window only when Maci'25 Ad.min is in 
administration mode. 

Sena- menu: In Mac}C25 Admin, a menu that is available 
only when the prosram is in administration mode. You use 
the Server menu to create, !IXXl.ify, start, stop, and delete 
MacX25 servers. 

sent'1' iafonmdon window: In MacX25 Admin, a window 
that you use to enter information about a specific MacX25 
server. Yoo can display this window only when Maci'25 
Admin is in adm.inistrat.ion mode. 

SUftt st2hll: In Mac}C25 Ad.min, the current status of a 
MacX25 server. 

SJgnals high: In MacX25 Admin, the status of a MacX25 
server after you start the server and before the server status is 
Active. This status appears when the Maci<25 server is 
connected to a modem. 

Slot Assjp.m.ent hem: In MaciC2S Admin, an area of a 
server information window in which you wign the MacX25 
server to a siot in the MacX25 gateway. 
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slot rondfdoa· In MacX25 Admin, the way that a slot 
appears in the MacX25 Admin window (in information 
mode) or in a sener iDfonnation window (in administration 
mode). The slot condition tells you if the expansion slot has 
an Apple Serial NuBus card and, if so, if the card is ruM.ing 
MacX25 software. 

Started: In MaciC25 Admin, the status of a MacX25 server 
after you choose the Start command to start the server. 

surtup disk: A disk with all the neceswy program fi.les­
such as the Finder and System file conlained in the Macintosh 
System Folder-to set the computer into operation. 

status dfalot: A dialog that MacP AD displays when you 
choose Status from the MacPAD menu. The status dialog 
contains Information about the current status of your 
connection. 

System Folder: The folder that contains all of the system files 
the disk on whrll it resides. 

system file: A file the computer uses to start itself up or to 
provide system-wide informatbn. Although system files are 
represented by icons just as c.kxumenrs and applicaOOns are, 
you can't open them in the same way. You can, however, 
alter the conrenrs of so.me system files. 

System: The set of files and resources in the System Folder 
that the computer uses to run itself. 

TeachText: An applicati>n that displays information from a 
ReadMe file. 

termhlal emulator: A program that makes a device look 
like amtm type of device. 

terminal settf.op document: A documem that a terminal 
emulator program, like MacTerminal, creates when you save 
a session to a file. You can double dick on a terminal se• 
document to launch the program with the ~ that are 
stored in the documem. 

terminal cool: A pqmm that performs a particular type of 
terminal enn11ariorJ aad that uses the Communications 
Toolbox to display 1be terminal type option to you. 

tamiaa1: A device connected to a network that can send 
and .receive dara. A terminal. generally has a saeen (or 
monitor) and a keyboard. 

User fafonudoa window! In MacX25 Admin, a window 
that you use to enier information about a specific MacX25 
user. You can display this window only when MacX25 
Mmin is in administration mode. 

User lilt wia&nr. In MacX25 Admin, a window that lists all 
cithe MacX25 users in the MacX25 gateway. You can display 
this window only when MacX25 Admin is in administration 
mode. 

UHr Interface: The appearance of the saeen, its layout, and 
all ci the options on the saeen. P.ach type of computer and 
each applicati>n has its own user intelface. On the Macintosh 
computer, the user interface of the Finder saeen is the 
Desktop. 

Users menu: In MacX25 Admin, a menu that is aV2ilable 
only when the program is in administration mode. You use 
the Users menu to aeate, modify, and delete MaciC25 users. 

Video c.ard: An expansion card for the Macinlo6h n f'am.ily 
computer that runs the monitor. 

'rirt1lal dmdt: An active amnection between two end 
poilts over an X.25 link. The end points are devices, usually a 
tat computer on one end and a terminal on the other, that 
reside outskie of the packet-switched data network. 

wide au network (WAN): A packet-switched data network. 

X.25 call: The process of establishing a connection with a 
remote computer or other device over an X.25 link. See also 
link. 

:US Chooeu document: System software that lets a 
MaciC25 user use the Ch<Qer desk accessory to gain acces.5 to 
a MacX25 server, and to copy enuies from the Master Address 
Book to a local Addresses file. 

X.25 couecdoa: A line of communicatioo between two 
poirus over an X.25 link. See also link. 

X.25 Uni: See link. 
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X.25 network a n'Ctha· A succes.Wl line of 
communicaticn belwen two poinrs over an X.25 link. See 
also link. 

x.25 network: See packet-switched data network. 

x.25 packet A message that is transmitted over an X.25 
netWork. A packet contains data or control information along 
with the information necessary for the network to deliver the 
packet to its intended destination and for the receiving device 
to perfonn error checking when the packet arrives. 
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X.25 senica: Access to information over a packet-switched 
data network. nu,, can include use of a publk netWOrk by 
lDt vendors and their users, and can mude the sale mi 
suppat of priwte X.25 netwcrks. 
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MacX25 Admin Quick Reference 

Using MacX2S Admln fo.r the first time 

1. Double-dick your hard dtik icon to open your hard disk. 

2 Locate the MacX25 Folder. 

3. Open the MacX25 Folder by double-dicking its icon. 

4. Double click the MacX25 Admin icon. 

• Spcdfylng your Adm11l key 

To specify your Admin key, follow these steps: 

1. Type the characters that you want for your Admin key 
and then click OK. · 

2 Click OK, if you want the characters that you just typed to 
be used as the Admin key. 

3. QickOK. 

• Putting MacX2S Admin Into administration mode 

To put MacX25 Admin into its administration mode, follow 
these steps: 

1. ChO<lie Administration from the Special menu. 

2 Type your Admin key, and click OK. 

• SaYin& the MacX2S lo& 
To save the contents of the Log window, follow these steps: 

1. Select the MacX25 Log window by clicking anywhere inside 
it. 

2 Choose Save from the File menu. 

3. Type a name for the new file, and click OK. 

.,......,, 

Creating a new MacX25 se.rver 

To create a new MacX25 server, follow these steps: 

1. Choose Create Server from the Server menu. 

2 Type in the name that you want to give to the new server. 

3. Click Select to see a list of the available parameter files. 

4. Click the name of the parameter file that you want the 
server to use, and click OK. 

5. Indicate in the check box whether you want MacX25 
Admin to automatically start this server each time you 
launch MacX25 Admin. 

6. dick the slot to which you want to assign the MacX25 
server. 

7. dick Save. 

• Startin& a MacX2S server 

To start a server: 

1. Select the server. 
2 ChCXlie Start from the Server menu. 

• Stopping a MacX2S server 
You can stop only a MacX25 server that is active or busy. To 
stop a server: 

1. Select the server. 

2 Choose Stop from the Server menu. 

3. Enter the number of minutes that you want MacX25 
Admin to wait before slopping the indicated server, and 
dick OK. 
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Creating a new MacX25 user 

To create a new user for the MacX25 gateway, follow these 
steps: 

1. Chouse Create User from the Users menu. 

2 Type the name that you want to give to the new user. 

3. Type a password for the user. 

4. Indicate in the check box that appears after Change 
Password Enabled whether you want the user to be able 
to change the password . 

5. Indicate in the check box next to each server name 
whether you want the user to have access to that server. 

6. dick Save. 

Creating the Master Address Book 

To open the Master Address Book, follow this inslruction: 

Choose Open Master Address Book from MacX25 Admin's 
File menu. 

• Adding entries to the Master Address Book 

To add new entries to the Master Address Book, follow these 
steps: 

1. Chouse New Entry from Open Book's Edit menu. 

2 Type the name that you wish to give the new entry. 

3. OickOK. 

• Putting lnfonnaUon into the X.2S Connection record 

To put infonnation into the X.25 Connection record, follow 
these steps: 

1. Select the X.25 Connection record. 

2 Click Edit. 

3. Type the full X.25 network address of the host. 

4. dick Save. 

• Putting lnfonnaUon into the X.25 Server record 

To put information into the X.25 Server record, follow these 
steps: 

1. Click on the X25 Server record. 

2 Click Edit. 

3. Select the AppleTalk zone to which your MacX25 gateway 
is connected from upper-left list box. 

4. Select the MacX25 Server that supports· connections to the 
host named in this entry from the upper-right list box. 

5. dick Save. 

Returning to information mode 

Choose Quit Admin from the File menu. 


